HydroDAS & MiniDAS
Oceanographic Data Acquisition Systems

USER’S MANUAL

Revision F
May, 2009

Hydro-Optics, Biology & Instrumentation Laboratories
Lighting the Way in Aquatic Science

www.hobilabs.com
support@hobilabs.com
Current Firmware Version: 3.28

*Other firmware versions may differ in some respects. Contact HOBI Labs for information on how to upgrade HydroDAS firmware.*

Current DASHost Version: 1.25

Users Manual Revisions:

Rev E, March 2008
- Formatting
- Rewrite sections 2, 3
- Remove references to frequency inputs
- Update deck box fuse ratings (section 6.1.2)

Rev D, October 2006
- Add Info command (section 9.8.5), INFO.LEVEL system variable (section 8.3)
- Add MountDisk, UnmountDisk commands (section 9.8.7)

Rev C, May 2, 2005
- Add format 17 to SENDDATE command (section 9.8.5).
- Add system variable substitution to HydroScript (section 9.6.5).

Rev B, April, 2004
Add information concerning hard disk storage and USB offload options.

- Section 2.4, revised warning to specify no non-silicone oils.
- Section 3.1, described DASHost directory in Common Applications Data folder.
- Section 3.1, added text concerning specific HydroDAS installer
- Section 3.3, revised procedure for first-time run.
- Section 3.7, now describes “Start and Collect Data” option
- Section 7, major reorganization, replaced all screen shots with 256-color "Brick" scheme screen shots.
- Section 7.2.2, added \D and \T options to Edit Commands window.
- Section 9.3, changed standard script extension from ".scr" with ".HDS" to eliminate confusion with screen saver executables (considered viruses in Outlook e-mails).
- Sections 9.7 and 9.8, added OS command, and added NewSeqNum parameter to ResetSeqNum command.
1 SYSTEM OVERVIEW ........................................................................................................... 1
  1.1 REAL-TIME PROFILING AND DATA MULTIPLEXING .................................................... 2
  1.2 PROGRAMMED AUTONOMOUS LOGGING .................................................................... 2
  1.3 MIXED MODES ............................................................................................................. 2
  1.4 AVAILABLE CONFIGURATIONS .................................................................................... 2

2 PRECAUTIONS ..................................................................................................................... 3
  2.1 DEPTH RATING .......................................................................................................... 3
  2.2 CONNECTORS ............................................................................................................. 3
  2.3 GROUNDING .............................................................................................................. 3
  2.4 HIGH VOLTAGE (NOT APPLICABLE TO ALL SYSTEMS) ............................................. 3
  2.5 HEAT DISSIPATION (HIGH-VOLTAGE SYSTEMS ONLY) .......................................... 3
  2.6 PROTECTING DATA MEMORY .................................................................................... 3

3 GETTING STARTED .............................................................................................................. 4
  3.1 INSTALL DASHost SOFTWARE ..................................................................................... 4
  3.2 CONNECT HARDWARE .............................................................................................. 4
    3.2.1 Systems without HOBI Labs Surface Unit ............................................................ 4
    3.2.2 Systems with HOBI Labs Surface Unit ............................................................... 4
    3.2.3 Connect Instruments to Sub Unit Ports ............................................................... 4
  3.3 STARTUP ..................................................................................................................... 4
  3.4 TROUBLESHOOTING ................................................................................................. 5
  3.5 SETTING UP INSTRUMENT PARAMETERS .................................................................... 5
  3.6 SELECTING DEVICES ................................................................................................. 6
  3.7 CONTROLLING DEVICES ......................................................................................... 6

4 SUBSURFACE UNIT HARDWARE .................................................................................. 8
  4.1 HYDRODAS AND MINIDAS CONFIGURATIONS ......................................................... 8
  4.2 CONNECTORS AND ENDCAPS .................................................................................. 9
  4.3 MAGNETIC SWITCH ................................................................................................. 11
    4.3.1 Sleep/Wake .................................................................................................... 11
    4.3.2 Script control ................................................................................................. 11
  4.4 INDICATOR LIGHT .................................................................................................. 11
  4.5 POWER SWITCHING ............................................................................................... 12
  4.6 SERIAL PORTS ........................................................................................................ 12
  4.7 ANALOG INPUTS ..................................................................................................... 12
    4.7.1 Standard analog inputs .................................................................................... 12
    4.7.2 Expanded analog inputs (optional) ................................................................. 12
  4.8 DIGITAL INPUTS ...................................................................................................... 12
  4.9 DIGITAL OUTPUTS .................................................................................................. 12
  4.10 DATA STORAGE ...................................................................................................... 13
  4.11 HOST PORT ............................................................................................................. 13
    4.11.1 Data Protocol Functions ................................................................................ 13
    4.11.2 Error-correcting Protocol .............................................................................. 13
    4.11.3 Error-detecting Protocol ............................................................................... 14
    4.11.4 Terminal Mode ............................................................................................ 14
  4.12 OPERATING SYSTEM (OS) PORT ............................................................................. 14
  4.13 USB DATA OFFLOAD PORT (OPTIONAL) ................................................................. 15
5 HOST COMPUTER REQUIREMENTS ................................................................. 16
5.1 CPU ............................................................................................................... 16
5.2 OPERATING SYSTEM .................................................................................... 16
5.3 SERIAL PORTS .............................................................................................. 16
  5.3.1 Host Port ................................................................................................. 16
  5.3.2 Device Ports and Serial Echo Ports ...................................................... 16
  5.3.3 Adding Serial Ports to the Host Computer ......................................... 16
5.4 USB PORT .................................................................................................... 17

6 POWER AND DATA INTERFACE ..................................................................... 18
6.1 POWER/DATA INTERFACE SURFACE UNIT ................................................ 18
  6.1.1 WARNING: HIGH VOLTAGE ............................................................... 19
  6.1.2 Fuses ....................................................................................................... 19
6.2 HOST DATA INTERFACE OPTIONS ............................................................. 20
  6.2.1 RS-232 ..................................................................................................... 20
  6.2.2 RS-485 ..................................................................................................... 20
  6.2.3 2-Wire Data/Power Interface ............................................................... 20
6.3 POWER OPTIONS ........................................................................................... 21
  6.3.1 Low-Voltage Input (12V nominal) ....................................................... 21
  6.3.2 60V Input ................................................................................................. 21
  6.3.3 300V Input .............................................................................................. 23

7 DASHOST SOFTWARE ...................................................................................... 24
7.1 DAS DESKTOP ............................................................................................. 24
  7.1.1 DAS Desktop Functions ......................................................................... 25
  7.1.2 Adding and deleting devices ................................................................. 28
  7.1.3 Multi-instrument configuration files ...................................................... 28
  7.1.4 Selecting the Master Directory ............................................................. 29
  7.1.5 Master archive Files .............................................................................. 29
  7.1.6 Setting up Host PC Serial Ports ............................................................ 31
  7.1.7 Selecting devices from the DASHost Desktop .................................... 32
  7.1.8 Changing the display of icons ............................................................... 32
  7.1.9 Opening DAS Explorer ......................................................................... 32
  7.1.10 Viewing DAS info, error, and other arbitrary channels .................... 32
  7.1.11 Opening terminal windows for devices .............................................. 33
  7.1.12 Host/HydroDAS Communications Statistics .................................... 33
  7.1.13 Controlling HydroDAS .......................................................................... 34
  7.1.14 Controlling Devices ............................................................................ 36
  7.1.15 Configuring individual devices ........................................................... 37
  7.1.16 Scripts .................................................................................................. 38
  7.1.17 Window Cascading & Other Window selection ................................ 39
  7.1.18 DASHost Help .................................................................................... 40
7.2 DEVICE SETUP WINDOW .............................................................................. 40
  7.2.1 Basic Properties Page ........................................................................... 40
  7.2.2 Power/Output/Priority Options Page .................................................. 42
  7.2.3 Data Capture Options Page ................................................................. 45
  7.2.4 Labels for Captured Data Page ............................................................. 47
  7.2.5 Captured Data Destinations Page ......................................................... 48
  7.2.6 Analog Options Page ............................................................................ 49
7.3 DAS EXPLORER ........................................................................................... 49
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.3.1</td>
<td>DAS Explorer Functions</td>
<td>50</td>
</tr>
<tr>
<td>7.4.1</td>
<td>Basic Options Page</td>
<td>52</td>
</tr>
<tr>
<td>7.4.2</td>
<td>Sample Options Page</td>
<td>53</td>
</tr>
<tr>
<td>7.4.3</td>
<td>Scheduling Page</td>
<td>54</td>
</tr>
<tr>
<td>7.5.1</td>
<td>Terminal Window Functions</td>
<td>56</td>
</tr>
<tr>
<td>7.5.2</td>
<td>Redirecting real-time data to other PC serial ports</td>
<td>58</td>
</tr>
<tr>
<td>8</td>
<td>OPERATING SYSTEM (OS)</td>
<td>60</td>
</tr>
<tr>
<td>8.1</td>
<td>Communicating with the OS</td>
<td>60</td>
</tr>
<tr>
<td>8.2</td>
<td>Disk and file handling</td>
<td>60</td>
</tr>
<tr>
<td>8.3</td>
<td>System variables</td>
<td>60</td>
</tr>
<tr>
<td>9</td>
<td>HYDROSCRIPT COMMAND LANGUAGE</td>
<td>62</td>
</tr>
<tr>
<td>9.1</td>
<td>Overview</td>
<td>62</td>
</tr>
<tr>
<td>9.2</td>
<td>Scripted vs. Immediate Command Execution</td>
<td>62</td>
</tr>
<tr>
<td>9.3</td>
<td>Script Files</td>
<td>62</td>
</tr>
<tr>
<td>9.4</td>
<td>Loading and Running Scripts</td>
<td>62</td>
</tr>
<tr>
<td>9.5</td>
<td>Script Setups for Delayed Starts</td>
<td>63</td>
</tr>
<tr>
<td>9.5.1</td>
<td>Logging starts upon connection of power</td>
<td>63</td>
</tr>
<tr>
<td>9.5.2</td>
<td>HydroDAS sleeps until wakened by switch</td>
<td>63</td>
</tr>
<tr>
<td>9.6</td>
<td>Script Syntax</td>
<td>63</td>
</tr>
<tr>
<td>9.6.1</td>
<td>Line Format</td>
<td>63</td>
</tr>
<tr>
<td>9.6.2</td>
<td>Label Definition</td>
<td>63</td>
</tr>
<tr>
<td>9.6.3</td>
<td>Separators</td>
<td>64</td>
</tr>
<tr>
<td>9.6.4</td>
<td>Command</td>
<td>64</td>
</tr>
<tr>
<td>9.6.5</td>
<td>Parameters</td>
<td>64</td>
</tr>
<tr>
<td>9.6.6</td>
<td>Comments</td>
<td>65</td>
</tr>
<tr>
<td>9.7</td>
<td>Command Summary</td>
<td>66</td>
</tr>
<tr>
<td>9.8</td>
<td>Command Reference</td>
<td>68</td>
</tr>
<tr>
<td>9.8.1</td>
<td>Flow Control</td>
<td>68</td>
</tr>
<tr>
<td>9.8.2</td>
<td>File Operations</td>
<td>71</td>
</tr>
<tr>
<td>9.8.3</td>
<td>Serial Port Operations</td>
<td>73</td>
</tr>
<tr>
<td>9.8.4</td>
<td>Digital I/O, Power</td>
<td>74</td>
</tr>
<tr>
<td>9.8.5</td>
<td>Messages</td>
<td>75</td>
</tr>
<tr>
<td>9.8.6</td>
<td>Analog Input</td>
<td>78</td>
</tr>
<tr>
<td>9.8.7</td>
<td>Miscellaneous</td>
<td>79</td>
</tr>
<tr>
<td>9.8.8</td>
<td>Script Control (see also section 9.4)</td>
<td>80</td>
</tr>
<tr>
<td>9.9</td>
<td>Example Scripts</td>
<td>81</td>
</tr>
<tr>
<td>9.9.1</td>
<td>Simple Analog Logging</td>
<td>81</td>
</tr>
<tr>
<td>9.9.2</td>
<td>Multiple Serial Instruments</td>
<td>82</td>
</tr>
<tr>
<td>10</td>
<td>USB DATA OFFLOAD</td>
<td>87</td>
</tr>
<tr>
<td>11</td>
<td>CUSTOMER SERVICE</td>
<td>89</td>
</tr>
</tbody>
</table>
1 SYSTEM OVERVIEW

HydroDAS (and the miniature HydroDAS, or MiniDAS) are submersible systems for handling power distribution, data acquisition, and programmable control functions for a wide range of oceanographic sensors, in a variety of deployment scenarios. Using HydroDAS, researchers can control an ensemble of instruments either with real-time commands from a host computer, with programs executed on the HydroDAS’s internal computer, or a mixture of the two. Similarly, data can be stored either in files in HydroDAS’s onboard flash memory, or sent to the host computer via a real-time multiplexed serial data stream.

![Diagram of HydroDAS deployment options]
1.1 Real-Time Profiling and Data Multiplexing

HydroDAS can be the basis for a profiling package deployed from a ship, with an electro-mechanical cable to carry power and data. In this application, HydroDAS allows data, commands and power for all the instruments to be carried on as few as two conductors, depending on the cable driver options selected (see section 5, for more details). Power may be supplied at high voltage to overcome the power losses in long cables. Data from the instruments are combined into a multiplexed serial stream that can be demultiplexed by the host computer on the surface. On the host computer, DASHost software can direct demultiplexed data from each channel to a file, a text terminal window, an RS232 serial port, or any combination of the three. Linking a data channel to an RS232 port provides a bidirectional connection to the instrument assigned to that channel (if the instrument also supports it). DASHost also provides a graphical “desktop” view of the individual instruments, and controls for turning individual power and data ports on and off.

1.2 Programmed Autonomous Logging

HydroDAS can also act as an autonomous controller for a moored system, or any other situation where a full-time electrical connection is not practical. In this mode power is typically provided by a battery pack, and data are stored in files in the internal flash memory under the direction of a program written in HydroDAS’s HydroScript language. The DASHost software includes a Script Wizard capable of automatically generating scripts for most applications, so the user need not know the details of HydroScript. However users with unusual requirements, or who simply prefer to control the details directly, can modify scripts generated by the Script Wizard, or create entirely new scripts without the Wizard. Every function of HydroDAS, except some that control script execution, is available from within scripts, and can be scheduled to occur at regular intervals, at arbitrary times of day, or even specific dates.

1.3 Mixed Modes

The distinction between real-time and autonomous applications is not inherent to HydroDAS. While functions like data multiplexing are best suited to a profiling application, they are still available for an autonomous system. Conversely, a system configured for real-time profiling and control by a human operator, can also be controlled by a script in the same manner as a battery-powered autonomous system.

1.4 Available Configurations

HydroDAS and MiniDAS are available in a variety of configurations with different connectors, various input and output capabilities, and optional memory and interface expansion. For a description of these options, see section 4.
2 PRECAUTIONS

2.1 Depth Rating

Unless otherwise stated in the HOBI Labs documentation for your system, the depth ratings for a standard HydroDAS (anodized aluminum) is 750 meters, and for a standard MiniDAS (acetal plastic) is 500 meters.

2.2 Connectors

- Occasionally lubricate the connectors with a silicone lubricant.
- DO NOT USE WD-40 OR ANY OIL-BASED LUBRICANT
- Use dummy connectors to protect the contacts when not in use.
- Use locking sleeves to prevent accidental disconnections.
- Do not expose connectors to water when power is applied.

2.3 Grounding

HydroDAS’s circuitry is isolated from its case. However other instruments may not be isolated, and any single instrument that connects to seawater will connect the entire system. This may be harmless, but depending on the power source and the individual instruments, could cause noise or even accelerate corrosion. Avoid seawater grounds when possible.

2.4 High Voltage (not applicable to all systems)

Some HydroDAS systems provide power over their sea cables at voltages that can be lethal. Only experienced electricians should install or modify wiring for these systems. If any symptom of malfunction, or evidence of damage to wiring, appears, immediately remove power from the system and use extreme caution to determine whether a hazard may have developed.

2.5 Heat Dissipation (high-voltage systems only)

High-voltage HydroDASs with heavy loads drawn by external instruments may become quite warm during extended operation. This will not be a problem when the system is submerged, but if operating the HydroDAS in warm air with a heavy load, beware of overheating. Do not operate a heavily-loaded HydroDAS in direct sun.

2.6 Protecting Data Memory

As with any computer, interrupting power while HydroDAS is writing to its flash memory can cause loss of data and possibly disrupt the formatting of the flash memory for future use. If your activities involve saving data on the HydroDAS’s on-board memory, do not turn off the power when it is actively collecting data. First stop any running scripts or any data collection within DASHost, or put the sub unit to sleep.
3 GETTING STARTED

3.1 Install DASHHost Software

- On your computer, run the program “Install_DASHHostXXX.exe”, where XXX is the version number (125 as of this writing).
- Also run the program “Install_HDXXXXXX.exe” where HDXXXXXX is the serial number of your HydroDAS. This will install files that describe the unique configuration of your system.

3.2 Connect Hardware

3.2.1 Systems without HOBI Labs Surface Unit:

- Connect the supplied data/power cable to the sub unit.
- Connect the cable’s power input to a 10 to 15V power supply.
- Connect the cable’s DB9 host connector (not the OS/Debug connector) to a serial port on your PC.

3.2.2 Systems with HOBI Labs Surface Unit:

- Connect the sea cable or equivalent between the surface unit and sub unit.
- Connect the deck unit “Host PC” port (not the OS/Debug port) to a PC serial port.
- Connect the surface unit to AC power.

3.2.3 Connect Instruments to Sub Unit Ports

- Details depend on your instruments and HydroDAS configuration. For purposes of introduction, we recommend you plug in a single instrument.

3.3 Startup

- Start the DASHHost software. If this is the first time it has been used on this computer, you will be prompted to locate a configuration file.
  - If a configuration file was supplied with your system, navigate to it and select it. By default, the installer places these files in C:\Documents and Settings\All Users\Application Data\DASHHost\Config.
  - To create a new, blank configuration file, click Cancel in the dialog box. You will be prompted to enter the name and location for a new configuration file, and then you will be prompted to select the internal configuration file (.icf) supplied with your HydroDAS. By default, the installer places this file in C:\Documents and Settings\All Users\Application Data\DASHHost\InternalConfig.
- Turn on surface unit or other power supply.
Within a few seconds the LED on the sub unit should illuminate. In the default configuration, it will turn green. If the system is set up to automatically run a script, the LED may turn red.

Within a few seconds the DASHHost window background should change from gray to white, and the top left status indicator should say “Connected to DAS”.

The status bar at the bottom of the window should also show the current status of the system, including internal temperature, supply voltage, and current (except on MiniDAS). If not, check Request Status Updates on the DAS menu.

3.4 Troubleshooting

If DASHost does not indicate that the HydroDAS is connected, check the following:

- Is the light on the HydroDAS sub unit on?
  - If it is green, go to the next step.
  - If it is red, try selecting Stop Script from the Scripts menu.
  - If it is dark, try selecting Wake HydroDAS from the DAS menu, or moving the external switch to the wake position (push the switch in the direction of the arrows marked on it).
  - If it remains dark after the above, check your wiring. If you are using a HOBI surface unit or your power supply has a current meter, check whether current is being drawn.

- If the sub unit’s light is green and you are confident the wiring is correct, but the DASHHost display does not indicate it is connected:
  - Select Set Up Communication Ports from the File menu, and note the dialog box that appears. Any changes you make in the following steps will take effect only when you click the OK button in this dialog box.
  - Verify that the Use as DAS Port button is selected next to the name of the PC port to which you connected the HydroDAS host port (not the OS/debug port). And correct it if it is wrong or in doubt.
  - Ensure that Error Correcting Protocol is selected.
  - Try selecting different baud rates.

3.5 Setting Up Instrument Parameters

The configuration (.das) file you selected or created in section 3.3 is for storing information about how the sub unit should communicate with each connected instrument. The parameters must be set according to the characteristics of each instrument. Doing this may take some research as well as experimentation. For a complete discussion of instrument setup, see section 7.2, “Device Setup Window.” For purposes of this brief introduction, we will assume you have connected a simple instrument that communicates via RS232 and is able to communicate as soon as power is applied to it.
• Click on the device icon in the DASHost desktop that corresponds to the instrument you have connected, then select **Device Setup...** from the **Device** menu. Or if there is no icon for the port you are working with, select **New Device** from the **Device** menu, and enter a name for the device.
• On the **Basic Properties** page of the setup dialog, select the DAS connector to which your device is connected.
• Click the **Setup** button to select the appropriate baud rate and other communication parameters.
• Click **Finished**.
• Double click on the instrument icon to open a window to the instrument.
• From this window’s menu, select **Device... Device On**.
• The window will now operate as a terminal to the instrument.
• Once basic communications have been confirmed, select **Device... Device Off** to shut down the device. Close the window if you prefer.

### 3.6 Selecting Devices

You can select one or more device icons to tell DASHost which devices should be affected by commands you select from the **Device** menu.

- To select an instrument to control, click on its icon.
- To select multiple instruments hold down the control or shift key while clicking on their icons, or drag a selection box around several instrument icons.
- To select all instruments, choose **Select All** from the **Edit** menu, or press control-A.
- If you select a device command when no icons are selected, it will apply to ALL devices.

### 3.7 Controlling Devices

Once you have set all the appropriate parameters for each instrument, as described in section 7.2, you can use commands on the **Device** menu to control them. Most commonly, you will use the **Start and Collect Data** and **Stop Data and Shut Down** commands (which on the toolbar as the and buttons). These commands initiate sequences of events that can be complex, depending on the instrument parameters you have set. You can also execute individual parts of these sequences as follows.

- To turn power to a device on or off, establish or cease communication with it, and send its startup or shutdown commands (if any), select **Device On** or **Device Off**.
- To send the commands (if any) that start or stop data flow from the instrument, select **Start Data** or **Stop Data**.
- To start or stop capturing data from a device in a file (either on the host computer or sub unit), select **Start Capture** or **Stop Capture**.
The commands on the **Device** menu are also available in several other ways:

- On a menu that pops up when you right-click on a device icon
- On the Device menu that appears in each terminal window (this menu only applies to the device connected to that window)
- By double-clicking in instrument status fields that appear in the DASHost Desktop’s “Details” view. For example, when a device’s power is shown as “off”, double-clicking on the word “off” will turn the device on.
4 SUBSURFACE UNIT HARDWARE

4.1 HydroDAS and MiniDAS Configurations

HydroDAS and MiniDAS contain a range of subsystems, with various inputs and outputs. The number and type of inputs and outputs that are actually accessible depends on the connector configuration specified at the time of manufacture. HOBI Labs can also change the configuration later. For information on the exact configuration of your HydroDAS system, see the configuration sheet that was supplied with it.

MiniDAS functions identically to HydroDAS in most respects, but is more restricted in the number and variety of its inputs. Because it does not support high-voltage input power, it cannot deliver large amounts of instrument power over long cables. Therefore it is best suited for applications where power is supplied by a battery pack or other source that is physically near. However MiniDAS does provide the same data multiplexing as HydroDAS, and with the optional RS485 interface it can send multiplexed data and commands over long cables.

<table>
<thead>
<tr>
<th>Feature</th>
<th>HydroDAS</th>
<th>MiniDAS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case Size</td>
<td>11.7 cm diameter, 33.6 cm long</td>
<td>13.3 cm diameter, 18.5 cm long</td>
</tr>
<tr>
<td>Weight</td>
<td>3.6 kg in air (depends somewhat on options)</td>
<td>1.8 kg in air (depends somewhat on options)</td>
</tr>
<tr>
<td>Instrument connector options</td>
<td>• 1 segmented connector (6 ports)</td>
<td>4 individual instrument connectors plus power input (5 instrument connectors upon special request)</td>
</tr>
<tr>
<td></td>
<td>• 2 segmented connectors (12 ports)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Individual instrument connectors (up to 12)</td>
<td></td>
</tr>
<tr>
<td>RS-232 Instrument Ports</td>
<td>3, 7 or 11</td>
<td>3 or 7</td>
</tr>
<tr>
<td>Switched power outputs</td>
<td>12</td>
<td>4</td>
</tr>
<tr>
<td>Analog Inputs</td>
<td>4 x 12-bit, 0 to 5V (standard)</td>
<td>4 x 16-bit, -10 to +10V, 45 kΩ input impedance</td>
</tr>
<tr>
<td></td>
<td>16 x 16-bit, -8 to +8V (optional)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>All inputs high-impedance.</td>
<td></td>
</tr>
<tr>
<td>Discrete digital inputs</td>
<td>8</td>
<td>None</td>
</tr>
<tr>
<td>Discrete digital outputs</td>
<td>8</td>
<td>None</td>
</tr>
<tr>
<td>Power input/output options</td>
<td>• 7 to 18V, unregulated output</td>
<td>7 to 18V input, unregulated output</td>
</tr>
<tr>
<td></td>
<td>• 60V, 12 to 15V regulated output</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 300V, 12 to 15V regulated output</td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>HydroDAS</td>
<td>MiniDAS</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Data storage</td>
<td>• Flash memory, 128 MB to 8 GB</td>
<td>Flash memory, 128 MB to 8 GB</td>
</tr>
<tr>
<td></td>
<td>• Special configurations: hard disk storage up to 8 GB (in 4, 2-GB partitions)  *</td>
<td></td>
</tr>
<tr>
<td>Host data interface options</td>
<td>• RS-232</td>
<td>• RS-232</td>
</tr>
<tr>
<td></td>
<td>• RS-485</td>
<td>• RS-485</td>
</tr>
<tr>
<td></td>
<td>• 2-wire combined data and power</td>
<td>• USB for data offload*</td>
</tr>
<tr>
<td></td>
<td>• USB for data offload*</td>
<td></td>
</tr>
<tr>
<td>HydroScript programming</td>
<td>YES</td>
<td>YES</td>
</tr>
<tr>
<td>Live multiplexing of all</td>
<td>YES</td>
<td>YES</td>
</tr>
<tr>
<td>instrument channels</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deck Unit required?</td>
<td>• Low-voltage, RS-232 configuration: NO</td>
<td>• RS-232 configuration: NO</td>
</tr>
<tr>
<td></td>
<td>• High-voltage and long cable configurations: YES</td>
<td>• RS-485 configuration: deck box or 3rd-party RS232-RS485 converter</td>
</tr>
</tbody>
</table>

* These options require non-standard connectors and/or packaging. Systems including them will include addenda to this document.

4.2 Connectors and End caps

Following are the standard HydroDAS and MiniDAS connector/endcap configurations. Other configurations are possible, depending on the options you have selected for your system. If your system has a custom configuration, consult the addendum sheets that came with it.

![Figure 1 MiniDAS End cap Configuration](image-url)
Figure 2 HydroDAS-P Segmented "Pie" Connector Configuration

Figure 3 HydroDAS-M Multiport (Discrete Connector) Configuration
4.3 Magnetic Switch

HydroDAS and MiniDAS are equipped with magnetically-activated external switches (see Figure 1, Figure 2 and Figure 3) that can be used to control the sleeping/waking state of the system, as well as starting and stopping scripts.

Note that commands from DASHost or the OS port can override the switch’s setting. For example, it is possible for DASHost to wake the system even if the switch remains in the “sleep” position.

4.3.1 Sleep/Wake

By default, moving the switch to the “off” position, unless a script is running, will cause the system to go into its low-power sleep mode. For the MiniDAS, this means it will also stop supplying power to its instrument ports. Some HydroDASs can continue to supply power while they are asleep. If the system is asleep, moving the switch to the “on” position will wake it (and possibly start a script as well—see below).

It is possible to deactivate the switch’s “sleep” function by setting the system variable (section 8.3) SWITCH.SLEEP=0. However the switch will always wake the system if it is moved to the on position during sleep.

4.3.2 Script control

If a script is loaded into the DAS’s memory, moving the switch to the on position will by default start execution of the loaded script. This function can be disabled by setting the system variable SWITCH.ScripT=0.

In order for the switch to terminate a running script, the script must contain one or more OnSwitchOff statements (see section 9.8.1) that designate how it should respond to the switch. This is necessary because simply allowing the switch to interrupt a script at any point could put data at risk. A script may therefore respond slowly to the switch, depending on its sampling schedule. Also note that the setting of the SWITCH.SCRipt system variable does not affect whether a script can be terminated by the switch, only whether it can be started. In its default configuration the system, after terminating a script in response to the switch, will also go into its low-power sleep mode.

4.4 Indicator Light

HydroDAS and MiniDAS have a bi-color light-emitting diode (LED) to indicate the operating status of the unit. Normally this is dark when the unit is asleep, green when it is awake but not running a script, and red when a script is running. The LED can also be controlled from within a script to produce any desired pattern of colors, or even to turn off the LED to save power. The LED consumes roughly 30mW of power when on.
4.5 Power switching

Up to twelve switched power outputs are available (four on the MiniDAS). Each is protected with a 1.25A resettable fuse (other fuse ratings are available on special request). Upon request, power outputs can be combined to provide higher output current.

4.6 Serial ports

HydroDAS supports 3, 7 or 11 general-purpose serial ports. Ports support standard communication rates from 300 to 230,400 baud.

4.7 Analog inputs

4.7.1 Standard analog inputs

The base HydroDAS configuration includes eight analog inputs that provide 12-bit resolution over the 0 to 5V range. Three of these are reserved for housekeeping data (supply voltage, supply current, and internal temperature). A fourth may be used for a built-in pressure transducer. The remaining four or five are available as general-purpose inputs.

4.7.2 Expanded analog inputs (optional)

The expanded analog input option increases the number of inputs to 16 (in addition to housekeeping inputs), increases their voltage range to approximately ±8V, and increases the resolution to 0.3 mV. Analog inputs can also be wired as differential pairs.

4.8 Digital inputs

HydroDAS includes eight inputs designed to detect the state of discrete digital signals. The inputs are compatible with TTL, 5V CMOS and 3V CMOS logic levels. Series resistors are included to provide some protection against transients, but you should use care to avoid forcing these inputs outside the range of 0 to 5V with respect to the HydroDAS ground.

The SENDDIGITALIN command simultaneously reads the state of all 8 inputs and sends them as a string of 1’s and 0’s to the specified destination.

4.9 Digital outputs

HydroDAS includes eight discrete digital outputs that can be set to high or low logic level with the SETDIGITALOUT command. These outputs are generated by 3.3V CMOS drivers that produce TTL- and CMOS-compatible voltage levels. However 1-kilohm series resistors, which protect them against short circuits, may prevent them from sinking the full current required by some older TTL circuits.
4.10 Data storage

All HydroDAS systems are equipped with flash memory ranging from 16MByte to 8 GByte. For special applications, hard disks can also be accommodated. Hard disks have special mounting requirements and therefore require customized housings.

The HydroDAS operating system scripting language address storage volumes, whether flash or hard disk, in MS-DOS fashion. Flash is normally the “boot” volume, designated as C:. A hard disk, if present, is usually drive D:. Volumes are limited to 2 GB, so larger hard disks must be partitioned and will appear as multiple volumes.

4.11 Host port

Normally the host port communicates to a computer running the DASHost software for Windows, and uses a special protocol that provides data multiplexing and error correction. This protocol can be simplified or turned off for special applications.

4.11.1 Data Protocol Functions

The key features of the protocol are time tagging, error detection/correction and data multiplexing. Each packet is assigned a time tag so that sequences of data can be reconstructed after transmission. Each packet also includes a checksum that allows detection of transmission errors.

Data multiplexing means that data from different sources are packed together for transmission, but in such a way that they can be reassembled into independent data streams after they are received. Packets may be assigned to one of 256 channels. When packets are received by DASHost, individual channels may then be directed to files, serial ports and terminal windows on the host computer.

Typically, a channel will carry data received on a particular serial port of the sub unit, but under the control of HydroScript any type of data—strings, files, analog data, etc.—may be assigned to any channel. HydroDAS also reserves a few channels for particular types of information it uses, such as file directories and instrument status messages.

HydroDAS can be set to one of three protocol modes for its host interface, described below. Use extreme caution if changing modes, because different host software is required for the different modes. DASHost only directly supports the default, error-correcting protocol.

4.11.2 Error-correcting Protocol

Error-correcting protocol is the standard interface mode. In this mode each packet of data sent between the host and sub unit is checked for errors, and if any are found the receiving party requests the packet to be retransmitted. The sending party requires confirmation that each packet was received correctly before it will send any further packets. This process of checking and
confirming imposes a certain amount of overhead on the data flow, thereby reducing the maximum transfer rate, but assures error-free data even when the connection is noisy. It also means that communication is inherently half-duplex. That is, data travel only in one direction at a time. This mode is well suited to RS485 and 2-wire hardware interfaces, which are also inherently half-duplex.

### 4.11.3 Error-detecting Protocol

Error-detecting protocol uses the same packet formats as the error-correcting protocol, but does not require packet confirmation, and does not support automatic resending of packets. This allows it to operate at somewhat higher data rates, but it does not work well over a half-duplex (RS485 or 2-wire) interface, or one with a significant error rate.

The main uses for this mode are increasing transfer rate over a reliable full-duplex connection (such as a short RS232 cable), and for connecting the host port of one HydroDAS to an instrument port on another HydroDAS, for purposes of system expansion.

### 4.11.4 Terminal Mode

Terminal mode is intended for interfacing with a telemetry system or another automated data system that cannot support the packet protocol. In terminal mode commands and data are sent and received without any special formatting. Terminal mode does not provide time tagging, error detection or distinctions between data channels.

### 4.12 Operating System (OS) port

The OS port is an RS232 serial port that connects directly to the microprocessor in HydroDAS. While it is not required for routine use, it has several useful functions. In special circumstances when the HydroDAS firmware is not running, for example when loading new firmware, this port acts as the operating system console (see section 8).

When the firmware is running normally, it sends informational and debugging messages to the OS port. Additional messages, such as command acknowledgements, will be sent here if the “information destination” (set with the SETINFODEST command, or by the INFO.DEST system variable [section 8.3]) is set to SERIAL. The firmware will also accept commands sent to the OS port as if they were sent through the normal host channel, but does not require the special protocol used on the host port.

The OS port is available as SERIAL 0 to commands such as SENDSTRING that send information to instrument ports. ROUTESERIAL can be used to route instrument ports to the OS port, but the OS port cannot be routed to another destination.

The OS port’s default data rate is 9600 baud.
4.13 **USB Data Offload Port (optional)**

The USB data offload port is an option offered for special applications requiring more rapid transfer of logged data than is possible through the host interface. It is in addition to the host interface and offers simple access to the flash or hard disk storage in the HydroDAS, at rates of approximately 200 kBytes/second. With an appropriate adapter cable, it connects to a standard computer USB port. The USBLink Windows program, which is separate from DASHost, provides a simple interface for transferring files from the DAS to the PC. Before transferring data the HydroDAS must also be put into a special operating mode. See section 10 for details.
5 HOST COMPUTER REQUIREMENTS

5.1 CPU

DASHost runs well on Pentium-based desktop or laptop computers with a clock speed of at least 133 MHz, 128 MB RAM, and at least 10 MB of available hard disk space.

5.2 Operating System

DASHost requires Windows 95, 98, NT 4.0, Me, 2000, XP, or a subsequent 32-bit version of Windows with Microsoft Internet Explorer 4.0 or later installed.

5.3 Serial Ports

5.3.1 Host Port

The host computer must have at least one RS232 serial port to communicate with the HydroDAS Sub Unit or deck box. The host connection speed is usually set to 57.6 or 115.2 kBaud (see sections 4.10 and 7.1.14). The built-in serial ports of most desktop and laptop computers support rates up to 115.2 kBaud.

5.3.2 Device Ports and Serial Echo Ports

While they are not required for basic operation, many applications call for additional serial ports for communicating with other devices (see section 7.1.14), or for sending demultiplexed data to other computers or other software running on the host computer (see section 7.5.2). HydroDAS can support a large number of serial ports, if your computer is suitably equipped.

5.3.3 Adding Serial Ports to the Host Computer

Add-on ports come in two basic types. “Bus” types are plug-in cards for the PCI or ESA buses in desktop computers, or the PCMCIA bus in laptops. The other type connects through a USB port.

Bus cards tend to offer faster performance, but fewer ports, than USB options. Both typically provide baud rates up to 230.4 kBaud, but USB ports have slightly more latency between the time the computer sends data to them, and the data actually emerge from the port. In most cases this difference in timing is not significant, but if a USB port is used as the host port, it may have a noticeable effect on the peak transfer rate between HydroDAS and the computer.
5.4 USB Port

HydroDAS systems equipped with the optional USB data offload port will require a USB port on the host computer. A USB port may also be used in lieu of serial ports, with a suitable adapter, as noted above.
6 POWER AND DATA INTERFACE

HydroDAS systems can be configured with various data and power interfaces (see section 4.1 for a description of configuration options). The baseline configuration takes a 12V (nominal) input and communicates via RS-232, similarly to many other oceanographic instruments. This configuration is best suited for stand-alone logging applications, where the source of power (typically a battery pack) is nearby, and a short cable can be used for configuring the system and offloading stored data. Depending on cable type, data rate, and system power load, the useable cable length for this configuration may vary between about 10 and 100 meters. For longer cables, additional interface options are available.

The table below shows the available combinations of data and power interface. The individual options are described further below.

<table>
<thead>
<tr>
<th></th>
<th>12 V</th>
<th>60 V, 1.0 A</th>
<th>60 V, 2.3 A</th>
<th>300V</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-232</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RS-485</td>
<td>OK*</td>
<td>OK*</td>
<td>OK*</td>
<td>OK*</td>
</tr>
<tr>
<td>2-wire</td>
<td>OK*</td>
<td>OK*</td>
<td></td>
<td>OK*</td>
</tr>
</tbody>
</table>

*HOBI Labs deck unit required, not available for MiniDAS

6.1 Power/Data Interface Surface Unit

The HydroDAS surface unit (deck box) provides power and data conversion for HydroDAS sub units that are configured with high voltage power supplies and/or data interfaces other than RS-232. 12-volt, RS-232 sub units do not require a special deck box.

The unit has connections for AC power in, an RS-232 connection to the host computer, an optional RS-232 connection to the sub unit’s OS port (section 4.12), and a connector for an underwater cable connecting to the sub unit. The only control is an on/off switch on the AC power entry module. This controls all power to the unit.

A red LED next to the sea cable connector indicates when high voltage is present on that connector. Note that the high-voltage power supply can store considerable energy, so the output voltage, and the indicator light, may remain on for some time after the power is switched off or removed from the unit.

A current meter shows how much current is being sent to the sea cable.
6.1.1 WARNING: HIGH VOLTAGE

Depending on the system configuration, the deck unit may produce voltages up to 300 VDC.

- Use great caution with wiring between the deck unit and sub unit—regularly check for damaged or exposed connections.
- Do not make or break the sea cable connection when power is applied to the deck unit.
- Observe the red power indicator, but assume that high voltage could be present even if the power indicator is dark.
- Do not replace fuses with any of a different type or rating.
- Do not open the deck unit.

6.1.2 Fuses

The deck unit has fuses both for the incoming AC power, and for the DC power sent to the sea cable. All fuses are 5 x 20 mm glass types.
# 6.2 Host Data Interface Options

## 6.2.1 RS-232

The RS-232 host interface allows connecting HydroDAS directly to a computer COM port and is therefore the simplest to use. RS-232 is not guaranteed to work over cables more than a few meters long, although it often works over at least several tens of meters. RS-232 uses one wire to transmit and one to receive, in addition to a ground wire that can be shared with the power supply. Power and RS-232 together therefore require 4 wires. We do not recommend using RS-232 with high-voltage power supplies, because voltage transients and steady-state voltage drops in the power ground can interfere with data transmission.

## 6.2.2 RS-485

Like RS-232, RS-485 uses a pair of wires for data, separate from the two wires needed for power. Unlike RS-232, it drives the wire pair differentially, alternating the direction of transmission on both wires together. Differential transmission allows RS-485 to carry signals over much longer distances—up to several km, depending on cable characteristics. Connection to a computer serial port requires a converter. To prevent problems due to voltage drops on long cables, the converter supplied as part of the optional HOBI Labs deck box provides galvanic isolation between the RS-485 signal lines and the power supply ground. RS-485 interfacing can be used with any power supply voltage.

HydroDAS sub units equipped with RS-485 use an ultra-low-power transceiver that remains active even when the unit is in its low-power sleep mode.

## 6.2.3 2-Wire Data/Power Interface

The 2-wire interface allows both data and power (60V or 300V) to be carried on a single pair of wires. This requires use of a HOBI-supplied deck box containing a suitable power supply and data interface. The deck box provides an RS-232 output for connecting to a standard computer serial port.
The amount of current drawn in a 2-wire connection must be limited to 1A. This can limit the total power available from a 60V power supply, but is not a limiting factor for a 300V power supply.

The 2-wire interface draws a considerable amount of power from the HydroDAS power supply, even if the HydroDAS is in its sleep mode. Therefore it is not recommend for battery-powered long-term applications.

### 6.3 Power Options

#### 6.3.1 Low-Voltage Input (12V nominal)

In this configuration the voltage that HydroDAS sends to other instruments is taken directly from the same power source that supplies HydroDAS. HydroDAS will function properly with any input voltage from 7 to 18, but you must ensure that the power source voltage is suitable for all connected instruments to which HydroDAS will supply power.

With a 12V supply, the amount of power available to HydroDAS and attached sensors can be greatly reduced by the resistance of long cables.

#### 6.3.2 60V Input

For applications requiring transmission of substantial power over medium-length cables, the sub unit can be equipped with a DC/DC converter that accepts a nominal 60V input, and converts it to 14V-regulated output (the regulated output voltage can also be set at the factory to other values from 10 to 17V). The regulated voltage powers the HydroDAS circuitry and is also supplied to instruments powered by HydroDAS.

The amount of power available to the HydroDAS is a function of the voltage and maximum current supplied at the surface, the length and wire gauge of the cable, and the minimum operating voltage and efficiency of the DC/DC converter in HydroDAS. Figure 5 shows the maximum power as a function of length and wire gauge, accounting for all the other factors, for a system using the 60V, 2.3A power supply. In the upper left, linear portion of each curve, the power is limited by the maximum current output of the supply. As the cable length, and therefore the voltage drop in the cable, increases, the power becomes limited by the minimum voltage input of the sub unit’s voltage converter, and the curves become hyperbolic.

HydroDAS systems equipped with RS485 data interfaces (RS232 is not recommended for most high-voltage configurations) are limited to 2.3A input current by the deck unit power supply. Systems with the 2-wire power/data interface must be limited to 1A of supply current. As shown in Figure 6, this considerably lowers the maximum power in the current-limited, linear portions of the curves, but does not affect the voltage-limited, hyperbolic regime.
Figure 5--Maximum Output Power with 60V, 2.3A Supply (RS485 Interface)

Figure 6--Maximum Output Power with 60V, 1.0A Supply (2-wire Interface)
6.3.3 300V Input

Increasing the nominal cable voltage to 300V greatly increases the available power, even with relatively long cables. As shown in Figure 7, the power curves have no linear, current-limited regions, because the current never exceeds the 1A limit of the source supply. Rather, the 150W output limit of the sub unit converter limits the power for shorter and larger-gauge cables. Unlike 60V configurations, the choice of data interface (RS485 or 2-wire) does not affect the available power.

Note that the curves of Figure 7 are calculated based on 250V, rather than 300V supply. The actual output of the power supply may range from 250 to 300V depending on line voltage and load; we use the minimum value to provide conservative estimates of the available power.

Figure 7--Maximum Output Power with 300V Power Supply
7 DASHOST SOFTWARE

DASHost supports HydroDAS by:

- Controlling HydroDAS through a graphical interface for routine operations. This includes configuration, turning On/Off power outputs & serial ports, starting and stopping data flow from instruments, putting HydroDAS into low-power sleep & waking HydroDAS, and loading, running, and halting scripts.
- Configuring HydroDAS and attached devices. This includes configuring HydroDAS communication parameters and default power-on settings (default scripts, baud rates, etc). DASHost can configure settings for individual devices attached to HydroDAS, set data sampling & archiving parameters, set baud rates and communication settings for serial channels, and set the sampling frequency for analog channels.
- Displaying live housekeeping data. This includes a status line with temperature, supply voltage, supply current, depth (with optional built-in pressure sensor), and script status (running script, ready, sleeping, etc.).
- Handling high-speed serial data from sub-unit. This includes archiving data stream in a single file, displaying status (data, error rate) of data stream, redirecting de-multiplexed data to other serial ports, saving de-multiplexed data into individual files, managing terminal windows for communication to individual devices, and real-time display of analog readings.
- Handling scripts, through a script Wizard for auto-generating scripts, opening/editing/saving script files on the local computer, and uploading and downloading of scripts to/from the HydroDAS.

7.1 DAS Desktop

Figure 8, DASHHost Desktop with 6 devices shown (3 devices on)
The DASHHost desktop is the heart of the DASHHost program, and can be used alone, or in combination with other windows to control the HydroDAS and attached instruments. It offers a menu of most commands, a Toolbar of often-used commands, a status bar, and represents each attached device as an icon that can be manipulated to control the device. To operate on individual devices, you can select their icons with the mouse.

### 7.1.1 DAS Desktop Functions

There are many functions available from the DASHHost desktop menu. They will each be explored in detail in the following sections. In short, they include:

#### File Menu

- Adding new devices to the DASHHost Desktop (also on Device menu, see section 7.1.2).
- Loading and saving multi-instrument configurations (also on toolbar, section 7.1.2)
- Recording and playback of real-time master archives (also on toolbar, section 7.1.5)
- Setting Master Directory for captured data (section 7.1.14).
- Setting up Host PC serial ports (section 7.1.2)

#### Edit Menu

- Selecting devices from the desktop (also mouse drag, or Ctrl-A to select all)
View Menu

- Hiding the Toolbar or Status Bar
- Changing the display of icons (also on toolbar, section 7.1.7)
- Opening DAS Explorer (also on toolbar, section 7.3)
- Opening the Terminal window(s) for selected (also on Device Menu)
- Viewing DAS info, error, and other arbitrary channels (section 7.1.12)
- Viewing HydroDAS to DASHost transmission statistics (also on toolbar, section 7.1.12)
- Viewing DASHost to HydroDAS transmission statistics (section 7.1.12)

DAS Menu (section 7.1.13)

- Putting HydroDAS into low-power sleep and waking HydroDAS (also on toolbar)
- Resetting the HydroDAS from hard firmware crashes (rare).
- Sending specific HydroScript commands to the HydroDAS
- Setting the HydroDAS time and date
- Setting HydroDAS power-on default system variables (section 8.3)
- Setting the File Sequence Number (affects both Host and HydroDAS)
Control the sending of status information

**Device Menu / Pop-up Menu (section 7.1.14)**

- Right clicking on DASHost Desktop can bring up this menu.
- Opening terminal windows for selected devices (also by double-clicking on Device Icons)
- Turning on the selected instrument(s), starting data flow, and starting the collection of data, all in one operation (also on toolbar) -- applies to all devices if none are selected.
- Stopping the collection of data, stopping data flow, and turning off power of all selected devices, or all devices if none selected (also on toolbar).
- Turning on or off the redirection of serial data through an echo port.
- Turning on or off device power only
- Starting or Stopping device data flow only
- Starting or stopping device data capture only
- Adding new devices (also on File Menu)
- Configuring devices (also on toolbar)

**Scripts Menu (section 7.1.15)**

- New Script...
- Open Script...
- Script Wizard...
- Show Loaded Script...
- Run Loaded Script
- Stop Script
- Launching Script editor for New or existing scripts (also on toolbar)
- Launching the Script Wizard (also on toolbar)
- Displaying the script currently loaded into the HydroDAS (also on toolbar)
- Starting and stopping (also on toolbar)

**Window Menu**
- Window Cascading
- Other Window selection

**Help Menu**
- Shows About DASHost window, which has links to application and data directories.

### 7.1.2 Adding and deleting devices

To add a new device, select **New Device** from the **File** menu, from the **Device** menu, or from the **pop-up** menu that appears when you right-click on a device icon. You will be prompted for a device name. The name must be unique, or you will be prompted to enter it again. Subsequently, the Device Setup window will appear for that device (see Section 7.2). The Device Setup will assume that the new device is using the next available port. If not, a different port must be selected in the Device Setup window.

To delete one or more devices, select the device icon(s) and select **Delete Device** from the **Device** or **pop-up** menus. You will be asked to confirm that you really want to delete the device. If so, you will be asked if you want to export the device settings before deleting. This will save all the settings for the particular device, so that they can be easily recalled if the device is added back into the configuration in the future. If you select yes, the Device setup window will appear. This will give you a final chance to edit the settings and use the “Export Settings” feature in the Device Setup window (see Section 7.2.1).

### 7.1.3 Multi-instrument configuration files

The collection of DASHost Desktop icons and their settings (including terminal window settings) can be saved and/or loaded so that different configurations of instruments on the HydroDAS can be used over time without having to re-build the settings every time.

**Handling Configuration Files**

The **New Configuration** option on the **File** menu creates a blank slate with no icons. If you have modified the previously opened configuration in any way, you will be prompted to save the current configuration.
Open Configuration on the File menu (or on the Toolbar) will launch a dialog box that will prompt you for the name of a DAS Configuration file (*.das). Select the desired “.das” file, and the DASHost Desktop will arrange itself to the selected configuration.

Save Configuration on the File menu (or on the Toolbar) will save the current DASHost Desktop settings. Save Configuration As on the File menu will prompt you for a new name for the DAS Configuration file (*.das).

7.1.4 Selecting the Master Directory

![Figure 9, Setting the Master Directory](image)

The Set Master Directory option on the File menu opens a dialog menu that allows you to choose where data is captured to with either the Start and Collect Data command (also ) or the Start Capture command on the Device menu. The first option is whether to save data to the Host PC, or to nonvolatile flash memory on the HydroDAS. If “Save Data to Host” is selected, then a path will be shown under "Host Master Directory". All capture files will be saved to sub folder(s) of the selected Master Directory. The specific capture file for each instrument must be selected in the "Captured Data Destinations" page under Device Setup (see section 7.2.5). If "Save Data to DAS" is selected, all folder names will be ignored, and captured data will be saved to the current DAS directory.

7.1.5 Master archive Files

Archive files record the complete multiplexed data stream from HydroDAS. After they are recorded, they can be played back to provide demultiplexing of individual channels to files or serial ports, in the same manner as when collecting live data.

Recording

Selecting Record DAS Archive from the File menu or pressing on the Toolbar launches a dialog box, which will prompt you for the name of a DAS Archive file (*.dar). Select a directory and enter a name.

A message box will pop up that says:

Click to begin archive recording.
When you press “OK”, the archive recording will begin, and all data from the HydroDAS, including status packets, data from devices, and error messages will start to be recorded in a format that retains the timing of individual data packets. This data can be later played back. The time resolution on recorded and played-back data is about 50 milliseconds.

When you start recording, the “Connected to DAS” indicator in the top left status box will change to “Recording Archive.” The “Record DAS Archive” option will disappear from the file menu, as will the icon on the Toolbar. These will be replaced by a “Stop DAS Archive” option on the file menu, and the button. Recording will continue until stopped by the menu option or by the stop button shown above (recording also is stopped when the DASHost program is quit).

**Playback**

Often archive playback will be done to send data previously recorded from a serial device to its proprietary software running on another PC. If this is the case, then you may want to configure and open the “Echo Data” serial port for the serial device that is being played back before starting the archive playback.

Selecting **Play DAS Archive** from the **File** menu or pressing on the Toolbar launches a dialog box, which will prompt you for the name of a DAS Archive file (*.dar). Select the desired “.dar” file.

A message box will pop up that says:

**Play back at real-time speed?**

You can select ”Yes”, ”No” or ”Cancel”. If you select ”Yes” then data will be played back at the same speed it was recorded. If you select ”No” then data will be played back as fast as possible. In either case, another message box will pop up that says:

**Archive Stats at MM/DD/YY HH:MM:SS.**

**Click to start archive playback.**

If archive playback will be done to send data previously recorded from a serial device to its proprietary software running on another PC, then you may want to set the time and date on the 2nd PC to match the time and date indicated in the message box. You may even want to press the “OK” button on the message box at the same moment as the “OK” button on the 2nd PC’s time setting dialog.

When you press “OK”, the archive playback will begin, and all data from the HydroDAS, including status packets, data from devices, and error messages will start to be played back, either as quickly as possible, or in real-time. The time resolution on recorded and played-back data is about 50 milliseconds.

When you start playback, the “Connected to DAS” (or “Disconnected”) indicator in the top left status box will change to “Playing Archive.” The “Play DAS Archive” option will disappear.
from the file menu, as will the icon on the Toolbar. These will be replaced by a “Stop DAS Archive” option on the file menu, and the button. Playback will continue until stopped by the menu option or by the stop button shown above (playback also is stopped when the DASHHost program is quit).

### 7.1.6 Setting up Host PC Serial Ports

**Setup Communication Ports** on the File menu opens a dialog box that can be used to configure the serial ports on the Host PC. The top half of the dialog box will show all the available serial ports on the Host PC, along with two options for each port.

Only one port can be selected for “Use as DAS Port”. This is the port that should either be connected directly to the HydroDAS communication port, or to the Deck box, depending on HydroDAS configuration.

Any of the remaining serial ports can be selected for use as a Device Port. Device ports can be used in Host mode only, but allow for the connection of devices directly to the Host PC that can subsequently be logged just as if they were connected to the HydroDAS. Examples of this sort of device would be surface reference radiometers, magnetometers, and GPS receivers.

Ports not selected as the DAS Port or as a Device Port can be used for serial data redirection as echo ports (see Section 7.5.2), or by other programs.

The lower half of the dialog box can be used to configure the serial communication settings for the Host PC to HydroDAS connection. If the DAS is currently connected, pressing OK will tell the HydroDAS to change its communication settings, and then quickly change the Host PC serial settings to match.

This dialog box allows selecting either the Error-Correcting or Error-Detecting protocol. The Error-Correcting protocol is the best choice for most normal circumstances.
7.1.7 Selecting devices from the DASHHost Desktop

Devices can be selected in several ways. The simplest is to click once on a device’s icon with the mouse. Multiple devices can be selected either by holding down the control key and clicking on additional icons, or by selecting a rectangle of icons by pressing the mouse cursor and dragging the selection rectangle over the icons you wish to select. All devices can be selected by using Select All on the Edit menu, or by typing Ctrl-A.

7.1.8 Changing the display of icons

The user has four options for display of instrument icons:

- For large icons, select Large Icons from the View menu (on the Toolbar).
- For small icons, select Small Icons from the View menu (on the Toolbar).
- For a list of small icons, select List from the View menu (on the Toolbar).
- For a detailed list of small icons, select Report (on the Toolbar).

In all modes, the icons can be sorted by selecting Device Name, Port Name, or Connection on the View…Arrange Icons menu.

In report mode, the icons can be sorted by the labels in any column simply by double clicking at the top of the column.

7.1.9 Opening DAS Explorer

DAS Explorer can be opened by using the DAS Explorer option on the View menu (or click on ). DAS Explorer also opens automatically if it was left open at the end of the last DASHHost session.

DAS Explorer has many of the same functions and capabilities as the Windows™ Explorer, and can be used to manage files stored on the HydroDAS. Files can be dragged and dropped between DAS Explorer and Windows™ Explorer. For more information, see Section 7.3.

7.1.10 Viewing DAS info, error, and other arbitrary channels

Additional data channels can be opened in terminal mode, mainly for debugging purposes. Selecting Info Channel from the View...Show Channels menu displays information transmitted from the DAS on Host channel 0. If the VERBOSE system variable (section 8.3) is set to true, this will include acknowledgements of every command that is sent from the Host to the HydroDAS.

Selecting Error Channel will show a dialog that is normally be blank, but will show the error(s) that arises if a user sends a direct command to the HydroDAS with bad syntax (or if a script executes a bad script line), or if an invalid port is selected for a DAS operation. For
example, if the wrong internal configuration file is selected, several errors may appear in this window.

Other channels, available by selecting Other Channels... can be defined within a script, as a channel for sending debugging messages, for example.

### 7.1.11 Opening terminal windows for devices

There are several ways to open the terminal window for a device. If one or more devices are currently selected, selecting **Show Device Window** on the View menu, Device menu, or pop-up menu will open the device window for each selected window. The pop-up menu will appear if you right click on any device icon. Alternatively, to open a single device window, just double click on the desired device icon, and the window will open.

For more on device terminal windows, see Section 7.5.

### 7.1.12 Host/HydroDAS Communications Statistics

**HydroDAS to Host transmission statistics**

By selecting **Show Host Statistics** on the View menu (or by pressing \[F3\]), the Statistics window opens up.

![Figure 11, HydroDAS to Host Statistics Window](image-url)
The statistics window can be handy for verifying data rates and debugging transmission problems. The error rate graph can be particularly useful when trying to set up long-cable communications. The data rate graph is for informational purposes only.

**Host to HydroDAS transmission statistics**

By selecting “Show DAS Statistics” on the View menu, a very verbose window will open up that shows the transfer statistics that are logged on the HydroDAS. These statistics follow the same format as the HydroDAS to Host transmission statistics, and are mainly used for debugging purposes.

### 7.1.13 Controlling HydroDAS

**Putting HydroDAS into low-power sleep and waking HydroDAS**

Selecting *HydroDAS Sleep* or *HydroDAS Wake* from the DAS Menu (or pressing ⌘ or *W*) has the obvious effect of either putting the HydroDAS into low power sleep, or waking the HydroDAS from low power sleep. When the HydroDAS is asleep, the DASHost screen will go gray, and the toolbar status indicator will say "Disconnected".

**Resetting HydroDAS**

On rare occasions, the HydroDAS firmware may crash, requiring a hard reset. Crashes can result from power transients when power loading on the system is near the limit imposed by the combination of cable resistance and power supply voltage. **Reset the HydroDAS**, from the DAS menu will perform a hard reset of the instrument. It will generally take about 30 seconds.

**Sending commands to the HydroDAS**

**Send Command…**, from the DAS menu, can be used to send commands unavailable from the toolbars and menus to the HydroDAS. Available commands are described in section 8. Selecting this option will open a dialog box with a menu.

![Figure 12, DASHost Send Commands Window](image)

Simply select the command you want to execute from the “Commands” menu. The command, with its correct syntax will appear in the edit window. Click “Send” to execute the command on the DAS. Clicking on the ![list](image) will display a list of previously used commands from this session that you can use.
Setting the HydroDAS time and date

![Figure 13, Setting HydroDAS Time and Date](image)

Selecting **Set DAS Time & Date** from the **DAS** menu opens the above dialog box. You can either set the DAS to match the PC clock, or to another time that can be entered into the edit window. The format of the text in the edit window must be Month/Day/Year Hour:Minute:Second, in 24-hour format.

Setting HydroDAS start-up options

![Figure 14, Setting HydroDAS start-up Options](image)

By selecting **Setup DAS Power-up Options** from the **DAS** menu, the above dialog box is displayed, showing user-settable system variable(s) and their current values. Initially, only the power-on script settings are shown, but by pressing the "Advanced→" button, several other options become available.

To change a variable, type the new value into the edit box to the right of the variable name. Then press the “OK” button to make the changes.

If "Script to load upon power-up" is set to the name of a script file that exists on the HydroDAS’s flash disk, that script will be loaded (see section 9.4) in preparation for running when power is first applied to the HydroDAS. If a valid file is specified and "Run script automatically upon power-up" is checked, then the script will run as soon as it is loaded.

Setting the File Sequence Number

“Set File Sequence Number”, on the DAS menu will prompt you for the number to label the next sequentially numbered file. See section 9.8.2 for more information about sequentially numbered files. Note: the HydroDAS must be connected in order for the new sequence number to be set on the HydroDAS. Otherwise, the sequence number will apply to Host-captured data only.
Controlling status updates

The final two items on the DAS menu control the updating of the device power and port status indicators, as well as the HydroDAS status information along the bottom of the DAS Desktop window. This information includes the HydroDAS’s internal temperature, its supply voltage output, current consumption, and whether a script is currently loaded, running, or stopped.

The Request Status Packets item on the DAS menu must be checked in order for this information to be updated. You set how frequently it is updated by selecting the Set Status Update Rate command. This prompts you to enter the number of milliseconds between updates. 100 is the minimum value for this setting.

Note that regardless of the above settings, status packets are halted during data file transfers.

7.1.14 Controlling Devices

Turning on or off device power, data flow, and capture

To turn on the selected instrument power, start data flow, and start collecting data to files on the PC, all in one operation select Start and Collect Data from the Device or pop-up menus (or press on the toolbar).

To stop collecting data, stop data flow, and turn off power, select Stop Data and Shut Down from the Device or pop-up menu (or press on the toolbar).

Turning on or off serial data redirection through an echo port

If an echo port is defined for a device, and that device is currently selected, the Open Serial Echo item will be enabled on the Device menu (and on the toolbar will also be enabled). Selecting this item will open up the echo port for serial redirection. See section 7.5.2 for more on serial redirection.

If an echo port is defined for a device, and that device is currently selected and its serial redirection echo port is currently open, the Close Serial Echo item will be enabled on the Device menu (and on the toolbar will also be enabled). Selecting this item will close the echo port for serial redirection.

Turning on or off device power only

Selecting Device On from the Device or pop-up menus will turn on power to the indicated device(s) (if the device ports are power-enabled). If the devices are serial devices, the serial port will also be opened, at the baud rate selected in the Device Setup window.
Selecting **Device Off** from the **Device** or **pop-up** menus will turn off power to the indicated device(s) (if the device ports are power-enabled). If the devices are serial devices, the serial port will also be closed.

If the serial baud rate or other serial parameters are changed through the Device Setup window (see Section 7.2.1), then the device must be turned off, and turned back on to use the new settings.

If the DASHHost Desktop is displayed in Report mode (see section 7.1.8) then the power and serial port states of one device may be individually toggled by double-clicking in their status boxes within the report view.

### Starting or Stopping device data flow only

Selecting **Start Data** from the **Device** or **pop-up** menus will start the data flow from the indicated device(s) (unless the device automatically and continuously sends data anyways). Data flow will commence from devices as configured in the Device Setup window (see Section 7.2.2).

Selecting **Stop Data** from the **Device** or **pop-up** menus will stop data flow from the indicated device(s) (unless the device automatically and continuously sends data).

If the DASHHost Desktop is displayed in Report mode (see section 7.1.8) then the data flow state of one device may be toggled by double-clicking in the Data status box for the device.

### Starting or stopping device data capture only

Selecting **Start Capture** from **Device** or **pop-up** menus will start capturing data from the indicated device(s) to a file on either the PC or on the HydroDAS, as configured in the Device Setup window (see Sections 7.2.4 and 7.2.5). If data is being captured to a file on HydroDAS, it will no longer appear in the instrument window.

Selecting **Stop Capture** from the **Device** or **pop-up** menus will stop the data capture from the indicated device(s) as configured in the Device Setup window (see Section 7.2.4).

If the DASHHost Desktop is displayed in Report mode (see section 7.1.8) then the capture state of one device may be toggled by double-clicking in the Capture status box for the device.

### 7.1.15 Configuring individual devices

Selecting **Device Setup** from the **Device** or **pop-up** menus (on the Toolbar) will launch the Device Setup window for the any selected device icons. Operation of the Device Setup window is discussed in Section 7.2. If multiple instruments are selected, a Device Setup window will appear for each selected instrument sequentially.
7.1.16 Scripts

Launching Script editor for new or existing scripts

Figure 15, Script Editor with script loaded

The **New Script** option on the **Scripts** menu (or on the Toolbar) will launch the Script Editor with a blank script. **Edit Script** on the **Scripts** menu (or on the Toolbar), will prompt you for a HydroDAS Script file (*.hds), and launch the Script Editor with that script. The script editor can also be launched by the Script Wizard (see following section).

The script editor has many of the same script editing and control functions as the DASHost Desktop, with one major addition: the ability to load and run the script in the editor. This can be accessed through the Script Editor’s Script menu, or via the Script Editor’s Toolbar button.

The script editor’s edit window is context colored to aid you in debugging syntax problems. Comments are **green**, HydroDAS keywords are **blue**, quotes are **purple**, and all other words and numbers are rendered in black.

Launching the Script Wizard

The Script Wizard is probably the best tool for generating scripts for autonomous operation. For very complex situations, the scripts that it generates can be edited in the Script Editor. The Script Wizard can be launched by selecting **Script Wizard** from the **Script** menu (or by pressing on the Toolbar). Use of the Script Wizard is discussed in Section 7.4.
Displaying currently loaded script

The Parsed Script Output window appears if you select Show Loaded Script from the Script menu (or by pressing on the Toolbar). It is useful for debugging, as it shows you exactly what script commands the HydroDAS was able to understand (converted to uppercase), along with their arguments, clearly labeled.

Starting and stopping scripts

The currently loaded script on the HydroDAS can be run with the Run Loaded Script command on the Script menu (or with on the Toolbar). The lower status bar message will change to “Running Script”, until the script ends, then will change to either “Script Done” or “Script Halted” (if the script ended with a stop command).

The currently running script can be halted with the Stop Script command on the Scripts menu (or with on the Toolbar))

7.1.17 Window Cascading & Other Window selection

DASHost typically opens a large number of windows, and if the user is not careful, those windows can get lost on the desktop. Note that only the DASHost desktop minimizes to the Taskbar, all other DASHost windows minimize just above the taskbar. Window cascading, available from Cascade on the Window menu, will arrange all the DASHost windows in a cascade, starting at the top left corner of the screen, and moving towards the bottom right corner of the screen.

Most often, however, you may want to just select one of the hidden DASHost windows from the Window menu on any other DASHost windows that has a menu.
7.1.18 DASHHost Help

The About DASHHost dialog is shown by selecting About DASHHost from the Help menu. In addition to indicating the current revision of DASHHost, the about box also has hot links to the e-mail address of service@hobilabs.com, to the HOBI Labs web site, to the application directory where DASHHost is installed, to the DASHHost User directory, and to the current directory.

7.2 Device Setup Window

Selecting Device Setup from the DASHHost Desktop Device or pop-up menus (or clicking on the Toolbar) will launch the Device Setup windows for the selected device icons. If multiple instruments are selected, a Device Setup window will appear for each selected instrument sequentially.

7.2.1 Basic Properties Page

The first set of options that appear for any instrument is the Basic Properties page. Through this page, you can set up basic instrument properties that will influence the rest of the Device Setup window pages.

![Figure 17, Basic Properties page of the Device Setup window](image-url)
Along the top of the page are two buttons: “Import Settings,” and “Export Settings.” With these buttons, you can save and retrieve the all the settings for an individual device, independent of all other devices (all devices are saved together when “Save Configuration” is selected from the DASHost Desktop).

Please note that one device property is not saved when a device is exported: the Connection, so be careful when importing devices that the correct type of connection is selected when they are imported (see paragraph below).

The **Identification** box is used to define the name of the device and to specify the graphical icon to use for the device. Any Windows bitmap can be used for a device icon – it will automatically be resized to 128x128 pixels for the large icons, and 64x64 pixels for the small icons. Internally, the icon locations are stored relative to the DASHost.exe executable.

The **Connection** box is used to select which physical port on the HydroDAS is to be used by the device. Either a physical connector can be selected, in which case the name of the functional “DAS port” changes to reflect the wiring of the connector, or a “DAS Port” can be selected, in which case the name of the physical connector will change to reflect the wiring of the connectors. In either case, the Host Channel number will change to tell you which channel DASHost has reserved for that physical port. If the port is a Serial port, the “Device Serial Settings” Setup button will be enabled. If so, it should be used to configure the HydroDAS port that will speak to the instrument.

The **Echo Data to PC Serial Port Options** box is used to set up the port that can be used by this device when redirecting real-time data to PC serial ports. See section 7.5.2 for more information.

Press the “Next ->” button to proceed to the “Power/Output/Priority Options” window page.
This window page will look slightly different for analog devices, since it will not have any of the Edit Commands options, no Power-off options, and fewer Data Output Style options.

The **Power-On Options** box is used to define how the instrument is powered-up. The “Min Delay to Next Instrument Power” specifies the pause between instrument power-ups, to minimize large current transients that could result in low voltages. If this is a serial device, there will be an option to send commands after power-on. If the box is checked and the “Edit Commands” button is pressed, an edit window will pop up:
This Edit Commands window can be used to send fairly sophisticated commands to an instrument, and can even contain HydroScript commands for the HydroDAS to execute while sending other commands to the instrument. In the above example, the following sequence of events will occur:

1. The text “time “ will be sent to the device, followed by the current HydroDAS date, followed by a space, then the current HydroDAS time, and finally a carriage return. If “Suppress Carriage Returns in the above lines” were checked, then the carriage return would not have been sent.
2. The HydroDAS will execute any commands that are prefaced by double backslashes. So the HydroDAS will execute the WaitTicks 100 commands, and wait for 1 second.
3. The text “power,1<carriage return>” will be sent to the device.
4. The DAS will wait 4 seconds
5. The text “again,0,1<carriage return>” will be send to the device.
6. The DAS will wait 1 second
7. The text “gain,0,5<carriage return>” will be send to the device.
8. The DAS will wait 2 seconds
9. The text “x<carriage return>” will be send to the device.

In the above example, there could have been:

- Lines of basic ASCII text to send to the instrument (like “power,1”)
- Lines with ASCII text and/or one or more of the following Escape sequences, all of which will be sent to the instrument:
  - \D Current HydroDAS date, as configured under the “Labels for Captured Data” tab (see section 7.2.4).
  - \T Current HydroDAS time, as configured under the “Labels for Captured Data” tab (see section 7.2.4).
  - \a bell
  - \b backspace
  - \f form feed
  - \n new line
carriage return (useful if “Suppress Carriage Returns” is checked)
\t horizontal tab
\v vertical tab
\xHH or \XHH any character denoted by the hex values HH
\\ \ character (not valid in first character of line. Must use \x5C)
\? ? character
\’ ‘ character
\" " character

- Lines that begin with \ followed by a HydroScript command. The “Wait” and “WaitTicks” commands are safe – multiple devices can request them simultaneously and not tie up the operation of each other. However, be careful with other commands that may cause the HydroDAS to pause for a while, as they will stop other devices from receiving their commands.
- A check in the “Suppress Carriage Returns in the above lines” which prevents carriage returns from being appended to the end of ASCII lines (and escape character) lines. HydroScript command lines (starting with “\\”) are not sent to the device, and will never have carriage returns appended to them.
- A value in the “Delay between each character” box. A value greater than zero here will slow down the transmission of characters from the HydroDAS to the device, for devices that can only accept characters typed slowly. It is best to use this setting sparingly, as the DAS can not send other strings to other instruments while it is sending a slow string.

The Power-Off Options box only appears for serial instruments. You can choose to send an instrument some commands before it is shut down. Like the power-on commands, you can specify the how long before power-off that these commands should be sent. It uses the same type of command editor as the Power-On Options box.

The Data Output Style box is very simple for analog instruments, but has many options for serial instruments. Data is assumed to flow from instruments in one of three modes:

1. HydroDAS requests or measures each piece of data from the device. This is the only option for analog devices, as the HydroDAS must make explicit measurements to record data. Within this option, you must specify how often measurements should be made by specifying the time between packets. Also, for serial instruments, you must specify the commands that the HydroDAS sends to the device to get the data packet. The default command is simply a carriage return (\r).
2. HydroDAS simply monitors and records the continuous stream of serial data that comes from the instrument. This is useful for instruments that have no built-in user interface, and generate data whenever they are powered.
3. HydroDAS sends a “Start Data” command and a “Stop Data” command. If this selection is made, you must specify the commands to send. By default, the command
“Start\texttt{r}” command is sent to start data and the “Stop\texttt{r}” command is sent to stop data. Sometimes the start command can only be issued after the instrument has warmed up for a while. In these cases, you can specify the minimum pause after power-on to send the “Start data” commands. Likewise some stop commands take a while to take effect, so you can specify them with a minimum pause so that power and communications will not be cut off before the command has completed.

The **Priority Options** box has two settings, “Power” priority, and “Data” priority. “Power” priority controls the sequence in which instruments are turned on when several instruments are turned on at once. The instrument with priority 1 is turned on first, followed by the instrument with priority 2, etc. This allows the user to turn on instruments with major start-up power requirements first, so that ample current is available and so that other instruments are not affected. “Data” priority controls the sequence in which data is requested from instruments when several instruments are polled for data at the same time. This is useful when that output from several instruments are routed to the same channel for tabular display (in most cases applies only to analog output devices).

### 7.2.3 Data Capture Options Page

![Data Capture Options Page](image)

Figure 20, Automatic Data Capture Options
The “Automatic Data Capture Options” page appears only for serial output instruments, and controls how data is captured from the instrument when the “Go” and “Stop” buttons are presses, or in autonomous mode scripts written by the Script Wizard (see Section 7.4). Some of the options will be enabled, and others will be disabled, depending on which value was selected in the Data Output Style box on the previous page.

The settings in the Automatic Start Data Capture box control when data starts getting captured from the device. There are several options, only one of which can be selected:

- **Start immediately before power is turned on**: this should be selected if power-on messages are important and should be captured. It may also capture some garbage characters that appear during the power-up current spike.
- **Start immediately before sending “power-on” commands**: this should be selected if power-on messages are not important, but responses to the power-on commands are important. This will be grayed-out if there are no power-on commands.
- **Start after power is turned on and any power-on commands are sent**: this should be selected if you want to capture everything that happened after the power-up sequence has completed.
- **Start immediately before sending “Start Data” or “Get Data” commands**: this should be selected if you want to capture the instrument’s immediate response to the “Start Data” command and all subsequent data.
- **Start after sending “Start Data” or “Get Data” commands**: this should be selected if you don’t want to capture the immediate response to the Start Data command (echo of the command, for example).
- **Start after sending “Get Saved Data” commands at the end of data collection**: this should be used to handle devices that log internally.

If a “Start after” option is picked, then you should indicate how long after in the edit space at the bottom of the box. If no “Start after” options are picked, this edit space will be grayed out.

The settings in the Automatic Stop Data Capture box control when data starts getting captured from the device. There are several options, only one of which can be selected:

- **Stop immediately before sending “Stop Data” commands**: this should be selected if you do not want to capture the device’s immediate response to the “Stop Data” command. This will be grayed out if “Start Data” and “Stop Data” commands are not used.
- **Stop after sending “Stop Data” commands**: this should be selected if you want to capture the device’s immediate response to the “Stop Data” command. This will be grayed out if “Start Data” and “Stop Data” commands are not used.
- **Stop immediately before sending “Power-Off” commands**: this should be selected if responses to the power-off commands are not important. This will be grayed-out if there are no power-on commands.
Stop after sending “Power-Off” commands: this should be selected if responses to the power-off commands are important. This will be grayed-out if there are no power-on commands.

Stop immediately before power is turned off: this will capture everything up until the point that the serial port is closed and the device shut down.

Stop after sending “Get Saved Data” commands at the end of data collection: this should be used to handle devices that log internally.

If a “Stop after” option is picked, then you should indicate how long after in the edit space at the bottom of the box. If no “Stop after” options are picked, this edit space will be grayed out.

7.2.4 Labels for Captured Data Page

The “Labels for Captured Data” page controls how text labels are inserted into the captured data stream. This page will appear for all types of devices.

The **Start of Captured Data Labels** box contains an edit field that is used to define the text that appears at the very start of captured data files. The text field can contain the Escape sequences defined previously for the Edit Commands window, as well as two additional escape sequences:

\T --> inserts the current time (in the format defined below)

\D --> inserts the current date (in the format defined below)
The Data Packet Labels box will only appear for devices that the DAS request data packets from. It contains two edit fields that are used to define the text that prefixes and suffixes each data packet. For serial instruments, only the prefix can be defined. The text field(s) can contain the Escape sequences defined for the Start of Captured Data Labels box.

The End of Captured Data Labels box contains an edit field that is used to define the text that appears at the very end of captured data files. The text field can contain the Escape sequences defined for the Start of Captured Data Labels box.

The Date Stamp Format box is used to defines how dates specified with the \D escape combination appear. The date format options are shown in Section 9.8.5 for the SendDate command.

The Time Stamp Format box is used to defines how times specified with the \T escape combination appear. Only the separator (";:" by default) can be specified.

### 7.2.5 Captured Data Destinations Page

The “Captured Data Destinations” page allows you to specify where data are saved to in both autonomous modes and host-controlled modes. This page also allows for the redirection of output to other host channels, which allows for the combination of many data streams into one terminal window. Please note that in Host mode data collection, the Master Directory is prefixed to the specified Device Folder/File. In DAS mode data capture, all folder names are ignored. Also, autonomous scripts can only save data to the DAS, not to the Host.
7.2.6 Analog Options Page

![Figure 23, Analog Options page]

This page only appears for analog output devices.

The first box, **Averaging Options – Scripted Mode Only** allows you to specify that each recorded analog measurement be the average of several measurements. For host-mode data collection, these settings will have no effect.

### 7.3 DAS Explorer

![Figure 24, DAS Explorer]

DAS Explorer can be opened from the DASHost Desktop by using the “DAS Explorer” option on the View menu (or click on the Toolbar). DAS Explorer also opens automatically if it was left open at the end of the last DASHost session.

DAS Explorer has many of the same functions and capabilities as the Windows™ Explorer, and can be used to manage files stored on the HydroDAS. Files can be dragged and dropped between DAS Explorer and Windows™ Explorer.
7.3.1 DAS Explorer Functions

Functions available from the DAS Explorer menu include:

**File Menu**

Many of the operations available on the file menu change the contents of the HydroDAS directory, and will require a refresh of the directory after they are executed. This may take a second or two. Options include:

- Creation of new Folders in the currently shown directory (also on the Toolbar)
- Creation of new Scripts in the currently shown directory (also on the Toolbar). Will prompt you for the Script Editor or Script Wizard.
- Managing the display of flash disk partitions. You can not edit partitions from the DAS Explorer, but if you have defined more than just the default C: partition on the flash disk, the Manage Partitions option on the File menu should be used to tell DAS Explorer about the additional drives.
- Sending of files to the HydroDAS. This can also be accomplished by dragging files from Windows™ Explorer or the Windows™ desktop to DAS Explorer. Please note that file transfers are much slower with DAS Explorer than with Windows™ Explorer. Also, DAS Explorer does not have the ability to drag and drop folders & sub-folders.
- Getting files from the HydroDAS. This can also be accomplished by dragging files from DAS Explorer to either a Windows™ Explorer window, the Windows™ desktop, or many Windows programs that accept dropped files. Alternatively, double click on the file, and you will be prompted for a folder to save the file to. Please note that file transfers are much slower with DAS Explorer than with Windows™ Explorer. Also, DAS Explorer does not have the ability to drag and drop folders & sub-folders.
- **Delete** files (or via the Delete key), deletes currently selected file(s). Will not delete directories that contain files. DAS Explorer may cause the HydroDAS to appear to disconnect if you delete a large file (>200K), as large deletions from the flash disk can consume a large amount of processor time, preventing other activities from continuing. However the HydroDAS should return to normal operation as soon as the deletion is completed.
- **Rename** the currently selected file. This can also be accomplished by slowly double clicking the mouse cursor on the file to be renamed.

**Edit Menu**

- **Delete** selected files from the HydroDAS.
- **Select All** files.
**View Menu**

- The user has four options for display of files and file information:
  - For large icons, select **Large Icons** from the **View** menu (or click on the Toolbar).
  - For small icons, select **Small Icons** from the **View** menu (or click on the Toolbar).
  - For a list of small icons, select **List** from the **View** menu (or click on the Toolbar).
  - For a detailed list of small icons (default), select **Report** (or click on the Toolbar).

- The directory view can be manually refreshed with the **Refresh** option (F5 from the keyboard). This is important to do if any process other than the DAS Explorer performs writes to the flash disk (script editor, script wizard, capture commands, or scripts themselves).

**7.4 Script Wizard**

The script Wizard is usually the best tool for generating scripts for autonomous (no Host) operation. For very complex situations, the scripts that it generates can be edited in the Script Editor. The Script Wizard can be launched from the DASHost Desktop by selecting **Script Wizard** from the **Script** menu (or by pressing on the Toolbar).

The Script Wizard contains several pages of settings, and the settings available in later pages will generally depend on what settings are selected in earlier pages. Every page has a set of buttons along the bottom. Navigation between pages is accomplished with the “←Back” and “Next→” buttons. At any point, the “Make Script” button can be pressed to generate a script, or the “Cancel” button can be pressed to close the window.
7.4.1 Basic Options Page

The “Basic Options” page contains basic, mandatory settings that are required in every Wizard-generated script.

The first box, **Script Identification**, is used to name the script, and determine where it is to be saved. If “Auto Run on HydroDAS Power-up” is selected, the HydroDAS startup parameters will be modified to run the indicated script automatically when the HydroDAS turns on. See also “Setting HydroDAS start-up options” on page 35.

Any text typed into the 2nd box, **Script Comments**, will be inserted into the top of the script as comment lines.

The option selected in the **Script Type** box will determine whether the script samples continuously, or if it samples on a set schedule. The options on later pages will depend on which of these options is selected.

The final box, **Devices to Use**, contains a check box for every device on the DASHHost desktop. Select the ones that the script will control.
7.4.2 Sample Options Page

![Sample Options Page]

The “Sample Options” page is used to configure a “sample” of measurements. Typically, a sample will contain several measurements, although it could contain only one measurement. The meaning of some of the settings on this page will depend on whether this script was set for continuous sampling or scheduled sampling.

The **Start-Up Options** box configures how the script starts up, allowing the script programmer to start the script before the HydroDAS is fully deployed, and initiate the script at a later time, or simply delay the start of the script for long enough that deployment equipment can be moved away, etc. The time setting in “Delay Sampling for:” will determine how long the HydroDAS remains in a sleep state after the script is started-up. The next two options determine whether the sleep switch needs to be toggled to start up the script. If “Wait for switch, then start up” is selected, the first line of the script will be a sleep statement, so running the script will put the HydroDAS to sleep. Once the HydroDAS is awoken, the countdown specified for “Delay Sampling for:” will begin, and then either continuous sampling or scheduled sampling will begin.
The **Shut Down Options** box will only appear if “Continuous Sampling” was chosen on the previous page. If “Go to sleep at the end of the script” is checked, the HydroDAS will go into low power sleep when continuous sampling is done. Depending on the selections in the next box, re-awakening the HydroDAS will either do nothing, or cause another sample to be made.

The **Sample Duration** box will determine the size of a data sample. For continuous sampling, the “sample” will be the entire data set, so the settings here will determine for how long the unit will sample before completing and going to low-power sleep (if that option was selected). For scheduled sampling the “sample” will be the data set collected at a scheduled time; additional “samples” will be collected at other scheduled times. There are three options:

1. Sample for a set period of time, then go to sleep. This is option will cause all the selected instruments to be sampled, in accordance with their settings in the **Data Output Style** box of the “Power/Output/Priority Options” page of their Device Setup window. If this is a continuous sampling script, and “Go to sleep at end of script” was checked in the **Shut Down Options** box, then you will be able to choose to have the sampling repeat when the HydroDAS is re-awoken.

2. Sample until checked serial instruments time out. A list of serial instruments that either sample automatically and continuously or require start/stop commands to sample continuously will be listed. These settings are configured in the **Data Output Style** box of the “Power/Output/Priority Options” page of each device’s Device Setup window. All instruments will sample until the checked device(s) stop sending data for the amount of time specified under “Time Out”. If the device does not stop sending data by the time specified under “Maximum Time”, sampling of all instruments will stop anyways. If this is a continuous sampling script, and “Go to sleep at end of script” was checked in the **Shut Down Options** box, then you will be able to choose to have the sampling repeat when the HydroDAS is re-awoken.

3. Sample Continuously. This will only appear if this is a continuous sampling script.

The final option in the **Sample Duration** box is a box where you can enter the delay before shutting down ports. This is not used, and will be removed in versions 0.51 and above.

### 7.4.3 Scheduling Page

![Scheduling Page](image)

*Figure 27, Scheduling page, for Simple Scripts*
The “Scheduling” page will contain one of two boxes, depending on whether this script was set for continuous sampling or scheduled sampling.

The **Blackout Times** box will appear if this is a simple (continuous sampling) script. It allows you to specify continuous sampling, except during the hours specified (at night, for example).

The **Sampling Schedule** box will appear if this is a scheduled script. Schedules can be either:

1. Regular: you specify intervals between samples, start time of day for samples to begin, and time of day for samples to end. Sampling will repeat on the same schedule every day.
2. Irregular: you specify specific times for samples to occur. Useful if you want to perform periodic sampling during the day, and one reference sample, say at midnight. Enter times into the box on the left, and click “Add Time→” to add the time to the schedule. To remove times from the schedule, select them in the right hand side box, and click on “←Remove Time(s).”

![Figure 28, Scheduling page, for Scheduled Scripts](image)
7.5 Terminal Windows

![Figure 29, Device Terminal Window, showing hex and ASCII data displays](image)

From the DASHHost Desktop, there are several ways to open the terminal window for a device. If one or more devices are currently selected, selecting **Show Device Window** on the **View** menu, the **Device** menu or the **pop-up** menu will open the device window for each selected window. The pop-up menu will appear if you right click on any device icon. Alternatively, to open a single device window, just double click on the desired device icon, and the window will open.

### 7.5.1 Terminal Window Functions

Functions available from Terminal Windows include:

**File Menu**

Only one option is available on the File menu:

- **Close** the window. This causes the window to disappear, but does not affect the flow of data that is reflected in the window, nor does it affect any of the functions (instrument power, data, or capture) that were initiated by the window. However, while the window is closed, its buffer will not fill with data, so that you cannot scroll back to see data that was collected while it was closed.

**Edit Menu**

Terminal window edit functions behave like standard text editor functions, but with a few particularities:

- **Cut**: this will remove the selected data from the terminal window and place it on the clipboard. Control-X will not work (it is passed on to the instrument), but Shift-Delete will work.

- **Copy**: this will copy the selected data from the terminal window to the clipboard. Control-C will not work (it is passed on to the instrument), but Control-Insert will work.

- **Paste**: this will send the pasted text to the connected device. Control-V will not work (it is passed on to the instrument), but Shift-Insert will work.
- **Delete**: this will remove the selected data from the terminal window. Just the Delete key will not work (it is passed on to the instrument), but Control-Delete will work.
- **Select All**: does what it says. Control-A will not work (it is passed on to the instrument), but Control-Home will.

**View Menu**

Options on the view menu affect how the text received from the attached device appears to the user.

- **View Hex**: this replaces the text-only window with a display that represents every received character as a two-character hexadecimal code (00 to FF represents ASCII codes 0 to 255). Line width and end of line codes are user-configurable through the “Change Hex Wrap” function, below. Text can be typed into the screen and sent to the device, but it must be entered as two-character hex codes.
- **View Hex and Text**: this splits the Terminal window into two resizable panes. The left pane will be a hex display as described above, and the right pane will be a text-only pane. If the left pane is selected, two-character hex codes must be typed to send data to the device. In the right pane, ordinary text can be typed.
- **View Text**: this is the default terminal mode. Received characters are shown as ASCII characters, and typed keys are sent as ASCII characters.
- **Change Font**: opens a font-chooser dialog box. All text in the hex and text terminal panes will be shown in the chosen font. Mono-spaced fonts are recommended.
- **Change Hex Wrap**: opens a series of dialog boxes that prompt you for:
  - Number of bytes to show per line – once this number of bytes is on a line, the line will automatically wrap. Remember, there will be twice as many characters shown as bytes received.
  - Lines will wrap after the specified hex bytes – often, this will be the termination character(s) of a binary packet protocol, or in the case of ASCII test, the code 0D0A, which corresponds to a carriage return/line feed.

**Device Menu**

The options in this menu are the same as the options in the **Device** menu of the DAS Desktop window (see also section 7.1.14), except that the actions selected here will affect only the associated device. In short, the options are:

- To turn on the selected instrument power, start data flow, and start collecting data to files on the PC, all in one operation select **Start and Collect Data**.
- To stop collecting data, stop data flow, and turn off power, select **Stop Data and Shut Down**.
- **Open Serial Port** and **Close Serial Port** (only one will appear at a time) can be used to toggle the state of the serial echo redirection port (see the next section). These options will only be enabled if a serial port is selected in the **Echo Data to PC Serial Port Options** box of the “Basic Properties Page” of the Device Setup Window for the terminal window’s associated device (see Section 7.2.1)
- **Device On** and **Device Off**: turns on or off device power.
- **Start Data** and **Stop Data**: starts or stops device data flow
- **Start Capture** and **Stop Capture**: starts or stops device data capture.
- **Device Setup**: configures device (see also section 7.2) Note that for changes to serial port baud rates to take effect, the device must be shut off and turned back on.

### 7.5.2 Redirecting real-time data to other PC serial ports

DASHHost cannot process data or display data graphically, and sometimes, it is necessary to see graphical data to properly interpret data, even during an experiment. Therefore, DASHHost makes it possible to export live data from the host PC to serial-port based software running on any other PC (or even the same PC).

Performing this procedure with real-time data will require a host PC with at least two serial ports and a second PC with one serial port (or just a Host PC with three serial ports). If the data were to be played back from an archive, only one serial port would be required on the host PC (or two if there is not a second PC).

It also requires at least one null modem cable with female DB-9 connectors on both ends (which may require one or two female-female gender changers).

From the File menu on the DASHHost Desktop, select “Setup Communication Ports,” to ensure that there is at least one port available for exporting data (i.e., not selected as either the DAS port or as a device port). If data is to be redirected to software running on the same PC, there should be two ports available. See Section 7.1.14 for more information on configuring communication ports.

Connect the null modem cable between the available serial port that is to be used for exporting data from DASHHost to the serial port that will be used by the data processing or graphing software.

Open the terminal window for the device that needs to have data redirected. Double clicking on the device icon is a quick way to open the terminal window. In the terminal window select **Device Setup** from its **Device** menu. In the Basic Properties page of the Device Setup window, under **Echo Data to PC Serial Port Options**, make sure that the “PC Serial Port” is set to one of the available serial ports, and that the “PC Serial Settings” are compatible with the graphing or processing software. See Section 7.2.1 for more information about basic device setup settings.
In the open terminal window, click on **Open Serial Port** from the **Device** menu. If there is an error, make sure that the serial port is not being used for something else.

Run the data processing or graphing software. Configure its serial port to use an available serial port, with the same settings that were selected in the Device setup window.

If it is not already turned on, select **Device On** from the **Device** menu of the terminal window. At this point, the data processing or graphing software should have full access and control of the device for both binary and ASCII data.
HydroDAS’s controller runs a simple operating system that provides basic DOS-like functions such as creating, changing and tracking files in the flash memory. Most users need not interact directly with the OS, but we will briefly discuss the features that may occasionally be useful.

### 8.1 Communicating with the OS

Under normal circumstances, when the HydroDAS firmware is running, you would send the OS command (see section 9.8.7) to the firmware, which then passes to the OS the command string you supply. For example, you could send the command OS “dir” to the HydroDAS to prompt a directory of the flash memory. Normally the OS sends any responses, such as directory information, to its console port. This is what we call the OS port (section 4.12). You can send commands to the OS either through the OS port, or by selecting Send Command from the DAS menu in the DASHost desktop window. Note that regardless of which port you send the commands through, the responses will normally be to the OS’s console port. However you can use the SetConOut command (section 9.8.7) to redirect “console” output to another DAS port or host channel.

You can also quit the DAS’s firmware program and communicate directly with the OS by sending the “exit” command to the DAS. This will cause all communication with the host port to cease; the only communication available at that point will be through the OS port.

### 8.2 Disk and file handling

The OS provides commands such as “del” and “ren” to delete or rename files, respectively. Normally you will use DASHost’s “DAS Explorer” to perform these functions.

### 8.3 System Variables

System Variables are nonvolatile parameters, maintained by the operating system, that control some aspects of the HydroDAS system’s behavior. Not all these will be present on every system, because they all have default values that are reasonable for many applications. There may be others as well, depending on your system configuration, but those generally should not be changed.

DASHost provides the means to control these settings through the HydroDAS Power-up Options command on the DAS menu (section 7.1.13). You can also access them through the OS’s “Set” command.

- AUTORUN—determines whether the script loaded at power-up (see INITSCRIPT) will automatically run.
- **HOST.PROTO**—sets the protocol used for communication between the DAS and the host computer (section 4.10). This is used only for special situations where the standard error-correcting protocol is turned off.
- **HOST.BAUD**—sets the baud rate of communications between the DAS and host computer. The default value (used if this variable is absent) is 115200 baud.
- **INFO.DEST**—set to either SERIAL or HOST to indicate whether informational messages will be sent to the OS Port or to the designated Host channel. These messages will be sent only if INFO.VERBOSE is also set to 1.
- **INFO.VERBOSE**—determines whether informational messages will be sent to the destination specified by INFO.DEST
- **INFO.LEVEL**—determines what type of messages will be allowed to be sent to the OS port (see “info” command, section 9.8.5). This does not affect messages of the type controlled by INFO.VERBOSE and INFO.DEST
- **INITSCRIPT**—sets the name of a script, if any, that is to be loaded into DAS memory at the time power is first applied.
- **SWITCH.SLEEP**—determines whether the external switch will put the DAS to sleep.
- **SWITCH.SCRIPT**—determines whether the external switch will initiate execution of a script.
- **PRSCALE**—scaling coefficient for a depth transducer, if one is installed
- **PROFFSET**—offset coefficient for a depth transducer, if one is installed

Advanced HydroScript users may wish to create their own System Variables to control aspects of how specific scripts run. See section 9.6.5 for details.
9 HYDROSCRIPT COMMAND LANGUAGE

9.1 Overview

HydroScript is the command language of HydroDAS. As a programming language, HydroScript can be used to construct simple or complex sequences of events, with timing determined by the real time clock, periodic intervals, or data flow from instrument ports.

The Script Wizard (section 7.1.16) produces scripts that are suitable for the vast majority of logging requirements, so most users do not need to understand the details of HydroScript. But advanced users may find they can optimize their systems by taking full advantage of the language’s capabilities.

9.2 Scripted vs. Immediate Command Execution

Most HydroScript commands can be executed in two ways: as a line in a script file, or immediately upon receipt through the host or OS port (whether or not a script is running). However some are restricted to one or the other. For example, the Script Control commands shown in section 9.8.8 cannot be used within scripts. Most of the Flow Control commands shown in section 9.8.1 can only be used within scripts. The command summary table (9.7) indicates which can be used for each command.

9.3 Script Files

Scripts are stored as plain text in files on the HydroDAS flash disk or on the Host PC. By convention they are stored with the extension “.HDS” (HydroDAS Script). They can be edited with any text editor, but it is usually best to edit them with DASHost’s built-in script editor (section 7.1.15).

9.4 Loading and Running Scripts

Before running, a script must be loaded into HydroDAS’s script memory. It can be loaded directly from a file on the HydroDAS flash disk using the LoadScript command (section 9.8.8), or sent by DASHost over a channel designated for sending scripts (channel 253). Lines sent on this channel, besides being loaded into the script memory, are collected by HydroDAS in a temporary file. This file can be saved under a different name by the SaveScript command (page 81).

Once a script is loaded, it can be run repeatedly without reloading. Status messages sent by HydroDAS indicate whether a script is loaded and/or running (see SendStatus DestType Dest# on page 76).

Part of the loading process is to parse the lines of the script into tokens that are used to represent commands during execution. The SendParsed command (page 81) sends the parsed
script lines to a host data channel designated for that purpose (channel 254). DASHost’s Show
Loaded Script… command causes the parsed script to be displayed in a DASHost window.

9.5 Script Setups for Delayed Starts

For some applications, especially long-term autonomous deployments, it may be desirable
to delay activation of logging until the system is deployed and has no connection to a host PC.
There are two primary methods to implement this.

9.5.1 Logging starts upon connection of power

If you set the INITSCRIPT system variable (section 8.3) to the name of a valid script file,
and the AUTORUN variable to 1, HydroDAS will load and run that script upon application of
power. Alternatively, if AUTORUN is set to 0 (or is absent entirely), the external switch will
control whether the loaded script will run upon application of power.

9.5.2 HydroDAS sleeps until wakened by switch

You may wish your HydroDAS to start script execution upon activation of its external
switch, for example if it is being placed by a diver and needs to be started after placement in the
water. The simplest way to do this is to load, but not run, a script, using DASHost, then put the
HydroDAS to sleep. Assuming you have not deactivated the switch feature (by setting the system
variable [section 8.3] SWITCH.SCRIPT=0), you can then simply start the loaded script by
turning on the switch.

Another approach is to place a SLEEP command with a very long sleep time before the
main part of your script. You would actually start the script with any other method (including the
power-activated start described above), but allow it to go to sleep until you are ready to resume it
with the switch.

9.6 Script Syntax

9.6.1 Line Format

An input script line has the following format:

<LABEL>: <SEP><COMMAND><SEP>[<PARAM><SEP>]; <COMMENT> LF

9.6.2 Label Definition

A label definition is any string (with no embedded spaces or commas) followed by a colon.
The label defines a destination line for a GOTO or GOSUB command. The label may, or may
not be followed by a command and comment.
9.6.3 Separators

The elements of a script line may be separated by one or more valid separator characters. The scripting language will accept either commas or spaces as separators.

9.6.4 Command

The command must be one of the valid commands of the scripting language. The command entry is not case sensitive.

9.6.5 Parameters

A command may accept up to four parameters. Each command data structure has a definition of the type and number of parameters it expects. Command parameters are divided into the following types:

Long Integer

Any integer numerical parameter is stored as a 32-bit long integer. Integers are used for channel numbers, file numbers, etc.

String

String arguments must be enclosed in quotation characters. Examples include file names, literal strings to be sent through a serial port or recorded in a file, and the format string “N81” used with the serial port setup command. Where appropriate, you may include control characters by using C language conventions (for example \n, \t, and \r). You may also include arbitrary characters with ‘\xNN’ where NN is the hexadecimal equivalent of the character (and must be exactly two digits). You may also embed quotation marks with the \ character sequence.

Data Destination

These define destinations to which data can be moved. For most commands with destinations this can be set to HOST, FILE, SERIAL or NONE. The SENDANALOG command also accepts a destination type of AVERAGE. The data destinations are not case-sensitive. In most cases the destination is followed by an integer that indicates the specific destination of the given type (file number, host channel, serial port).

Label

A label is used as the destination of a GOTO or GOSUB command. The label must match, in case and spelling, the label that is defined at the destination line. (Note that the colon suffix that separates the defining label at the beginning of a line is not treated as part of the label).
Date

A date is entered in MM/DD/YY format. Internally, all dates and times are converted to seconds from the start of the UNIX epoch, Midnight, January 1, 1970. The dates and times are stored as 32-bit long integers.

Time

Times are entered in either HH:MM:SS format or as an integer number of seconds. Internally, all dates and times are converted to seconds from the start of the UNIX epoch, Midnight, January 1, 1970. The dates and times are stored as 32-bit long integers.

System Variables

You may replace any argument with the name of a system variable enclosed in angle brackets (<>). The value contained by that system variable will be inserted automatically in the command. For example, if a system variable called REPEATS, and containing the value 5, exists, the following two lines are equivalent:

Repeat <REPEATS>
Repeat 5

This technique can be used for any type of argument including strings, but note that the operating system forces all strings to upper case when they are stored in system variables. For more about system variables, see section 8.3.

9.6.6 Comments

If a line contains a semicolon character, everything following the semicolon is treated as a comment and ignored by the command processor. Comments may include any combination of printable characters terminated with a Line Feed (as is normal in text editors).
## 9.7 Command Summary

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>Argument</th>
<th>Argument</th>
<th>Argument</th>
<th>Argument</th>
<th>Scripted/Immediate Execution</th>
</tr>
</thead>
<tbody>
<tr>
<td>EnableTimeout</td>
<td>SerialPort#</td>
<td></td>
<td></td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>EndRepeat</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Script</td>
</tr>
<tr>
<td>EndScript</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>Gosub</td>
<td>Label</td>
<td></td>
<td></td>
<td></td>
<td>Script</td>
</tr>
<tr>
<td>GosubDuring</td>
<td>Time1</td>
<td>Time2</td>
<td>Label</td>
<td>MaxCount</td>
<td>Script</td>
</tr>
<tr>
<td>Goto</td>
<td>Label</td>
<td></td>
<td></td>
<td></td>
<td>Script</td>
</tr>
<tr>
<td>OnLowBattery</td>
<td>Voltage</td>
<td>Label</td>
<td></td>
<td></td>
<td>Script</td>
</tr>
<tr>
<td>OnSwitchOff</td>
<td>Label</td>
<td></td>
<td></td>
<td></td>
<td>Script</td>
</tr>
<tr>
<td>Repeat</td>
<td>Count</td>
<td></td>
<td></td>
<td></td>
<td>Script</td>
</tr>
<tr>
<td>RepeatTimeout</td>
<td>TimeoutTicks</td>
<td>MaxTicks</td>
<td></td>
<td></td>
<td>Script</td>
</tr>
<tr>
<td>RepeatUntilString</td>
<td>SerialPort#</td>
<td>&quot;String&quot;</td>
<td>MaxTicks</td>
<td></td>
<td>Script</td>
</tr>
<tr>
<td>Return</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Script</td>
</tr>
<tr>
<td>Sleep</td>
<td>Seconds</td>
<td></td>
<td></td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>SleepMod</td>
<td>hh:mm:ss</td>
<td></td>
<td></td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>SleepUntil</td>
<td>MM:DD:YY</td>
<td>hh:mm:ss</td>
<td></td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>Wait</td>
<td>Seconds</td>
<td></td>
<td></td>
<td></td>
<td>Script</td>
</tr>
<tr>
<td>WaitMod</td>
<td>hh:mm:ss</td>
<td></td>
<td></td>
<td></td>
<td>Script</td>
</tr>
<tr>
<td>Waitticks</td>
<td>ticks</td>
<td></td>
<td></td>
<td></td>
<td>Script</td>
</tr>
<tr>
<td>WaitUntil</td>
<td>MM:DD:YY</td>
<td>hh:mm:ss</td>
<td></td>
<td></td>
<td>Script</td>
</tr>
<tr>
<td>AppendFile</td>
<td>File#</td>
<td>&quot;Filename&quot;</td>
<td></td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>CloseFile</td>
<td>File#</td>
<td></td>
<td></td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>Dir</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>NextSeqNum</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>Openfile</td>
<td>File#</td>
<td>&quot;Filename&quot;</td>
<td></td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>OpenFileSeq</td>
<td>File#</td>
<td>&quot;BaseName&quot;</td>
<td></td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>RcvFile</td>
<td>&quot;FileName&quot;</td>
<td></td>
<td></td>
<td></td>
<td>Immediate</td>
</tr>
<tr>
<td>ResetSeqNum</td>
<td>NewSeqNum</td>
<td></td>
<td></td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>SendFile</td>
<td>DestType</td>
<td>Dest#</td>
<td>&quot;FileName&quot;</td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>SendHostfile</td>
<td>&quot;FileName&quot;</td>
<td></td>
<td></td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>SendSeqNum</td>
<td>DestType</td>
<td>Dest#</td>
<td></td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>StopTransfer</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Immediate</td>
</tr>
</tbody>
</table>

### FLOW CONTROL (section 9.8.1)

### FILE OPERATIONS (section 9.8.2)

### SERIAL PORT OPERATIONS (section 9.8.3)
<table>
<thead>
<tr>
<th>COMMAND</th>
<th>Argument</th>
<th>Argument</th>
<th>Argument</th>
<th>Argument</th>
<th>Scripted/Immediate Execution</th>
</tr>
</thead>
<tbody>
<tr>
<td>ClearBreak</td>
<td>SerialPort#</td>
<td></td>
<td></td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>CloseSerial</td>
<td>SerialPort#</td>
<td></td>
<td></td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>OpenSerial</td>
<td>SerialPort#</td>
<td>Baud</td>
<td>“params”</td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>RouteSerial</td>
<td>SerialPort#</td>
<td>DestType</td>
<td>Channel</td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>SendBreak</td>
<td>SerialPort#</td>
<td>Ticks</td>
<td></td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>SetBreak</td>
<td>SerialPort#</td>
<td></td>
<td></td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>UnrouteSerial</td>
<td>SerialPort#</td>
<td></td>
<td></td>
<td></td>
<td>Both</td>
</tr>
</tbody>
</table>

**DIGITAL I/O, POWER (section 9.8.4)**

| AnalogPower      | OnOff            |          |          |          | Both                          |
| SendDigitalInput | DestType          | Dest#    |          |          | Both                          |
| SetDigital       | DigOut#          | OnOff    |          |          | Both                          |
| SetPower         | PowerOut#        | OnOff    |          |          | Both                          |

**MESSAGES (section 9.8.5)**

| Info             | InfoLevel        |          |          |          | Both                          |
| Log              | OnOff            |          |          |          | Both                          |
| LogDestination   | DestType         | Dest#    |          |          | Both                          |
| SendDate         | DestType         | Dest#    | “Separator” | Format# | Both                          |
| SendMuxStats     |                  |          |          |          | Immediate  |
| SendSerNum       | DestType         | Dest#    |          |          | Both                          |
| SendStatus       | DestType         | Dest#    |          |          | Both                          |
| SendString       | DestType         | Dest#    | “String” | TickDelay | Both                          |
| SendTime         | DestType         | Dest#    | “Separator” |          | Both                          |
| SetInfoDest      | DestType         | Only HOST, SERIAL and NONE destinations |          |          | Both                          |

**ANALOG INPUT (section 9.8.6)**

| ResetAverage     | Average#         |          |          |          | Both                          |
| SendAnalog       | ADInput#         | DestType | Dest#    |          | Both                          |
| SendAnalogDiff   | ADInput#         | DestType | Dest#    |          | Both                          |
| SendAverage      | Average#         | DestType | Dest#    |          | Both                          |

**MISCELLANEOUS (section 9.8.7)**

<p>| Define           | Name             | Value    |          | Script | Both                          |
| MountDisk        |                  |          |          |        | Both                          |
| OS               |                  | “command”|          |        | Both                          |
| SetConOut        | DestType         | Dest#    |          |        | Both                          |
| SetLED           | Color (0,1,2)    |          |          |        | Both                          |</p>
<table>
<thead>
<tr>
<th>COMMAND</th>
<th>Argument</th>
<th>Argument</th>
<th>Argument</th>
<th>Argument</th>
<th>Scripted/Immediate Execution</th>
</tr>
</thead>
<tbody>
<tr>
<td>SetProtocol</td>
<td>Baudrate</td>
<td>Protocol#</td>
<td></td>
<td></td>
<td>Both</td>
</tr>
<tr>
<td>UnmountDisk</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Both</td>
</tr>
</tbody>
</table>

**SCRIPT CONTROL (section 9.8.8)**

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>Argument</th>
<th>Argument</th>
<th>Argument</th>
<th>Argument</th>
<th>Description is under Flow Control, section 9.8.1</th>
<th>Scripted/Immediate Execution</th>
</tr>
</thead>
<tbody>
<tr>
<td>CheckScript</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Immediate</td>
<td></td>
</tr>
<tr>
<td>ClearScript</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Immediate</td>
<td></td>
</tr>
<tr>
<td>EndScript</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Immediate</td>
<td>Both</td>
</tr>
<tr>
<td>LoadScript</td>
<td>“filename”</td>
<td></td>
<td></td>
<td></td>
<td>Immediate</td>
<td></td>
</tr>
<tr>
<td>RunScript</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Immediate</td>
<td></td>
</tr>
<tr>
<td>SaveScript</td>
<td>“filename”</td>
<td></td>
<td></td>
<td></td>
<td>Immediate</td>
<td></td>
</tr>
<tr>
<td>SendParsed</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Immediate</td>
<td></td>
</tr>
</tbody>
</table>

### 9.8 Command Reference

#### 9.8.1 FLOW CONTROL

**EnableTimeout SerialPort#**

**Parameters:** SerialPort# specifies the serial channel for which timeout is enabled. It may be any instrument port but not the OS Port (port 0).

**Action:** Sets a flag that includes the defined channel in timeout operations. Whenever the channel receives serial input data, the timeout interval is reset. Multiple channels can be active simultaneously. At the completion of a RepeatTimeout loop, all channel timeouts are disabled. Therefore you must use EnableTimeout for each desired channel before each RepeatTimeout loop in which you wish it to be active.

**EndRepeat**

**Parameters:** NONE

**Action:** Transfer control to the preceding Repeat line, or terminate the Repeat loop if the conditions of the Repeat have expired. If terminating a RepeatTimeout loop, cancels the effect of any previous EnableTimeout commands.

**EndScript**

**Parameters:** NONE

**Action:** Halts the execution of the current script, if any. Unlike most other flow-control commands, EndScript can be received. The script processor will also halt after it executes the last line of a script.

**Exit**

**Parameters:** NONE
**Action**: Exit firmware, go to the operating system.

**GoSub Label**

- **Parameters**: Label defines the destination line.
- **Action**: Transfer control to the destination line in the script. Control will return to the following line on Return. GoSubs may be nested 8 levels deep.

**GoSubDuring Time1 Time2 Label MaxCount**

- **Parameters**: Time1 and Time2 are in HH:MM:SS format. Time1 is the earliest time at which the given Sub will be executed; Time2 is the latest. MaxCount sets the maximum number of times the subroutine will be called, regardless of the time limits.
- **Action**: Repeatedly calls a subroutine during a defined time interval. Calls the indicated subroutine, up to MaxCount times, if the current time is between Time1 and Time2. If no MaxCount is specified, or if MaxCount is zero, the number of repetitions will be limited only by the time. If Time2 is earlier than Time1, it is assumed to occur during the next day.

**GoTo Label**

- **Parameters**: Label defines the destination line.
- **Action**: Transfer control to the destination line in the script.

**OnLowBattery Voltage Label**

- **Parameters**: Voltage is the voltage below which program flow will be redirected. Label is the script label to which flow will be directed.
- **Action**: The HydroDAS supply voltage will be measured; if it is below the specified threshold, script execution will jump to the line specified by Label.

**OnSwitchOff Label**

- **Parameters**: Label is the script label to which flow may be directed.
- **Action**: The state of the HydroDAS’s external switch is tested. If it has been switched to the “stop” or “off” position since it was last checked, execution will jump to the line indicated by label. Typically this line will point to a routine that orderly ends the script.

**Repeat Count**

- **Parameters**: Count defines the number of times to repeat the script line between the Repeat command and the matching EndRepeat command.
- **Action**: Keep track of the number of times the intervening lines have been executed. Repeat blocks may be nested up to 8 levels deep.

**RepeatTimeout TimeoutTicks MaxTicks**

- **Parameters**: TimeoutTicks sets the timeout interval in hundredths of seconds. MaxTicks sets the maximum repeat time regardless of timeouts.
Action: Sets a counter that is decremented each 1/100th of a second. If there is serial input on any channel for which timeout is enabled, the counter is reset to the Timeout value. Note that you must use EnableTimeout before RepeatTimeout, to specify one or more ports that will be monitored. The loop will exit when the timer is decremented to zero, or after a total time of MaxTicks has passed. Thus, the loop will repeat until there has been no input on any enabled channel for TimeoutTicks, or until a total of MaxTicks ticks have passed, whichever happens first.

RepeatUntilString SerialPort#, “String”, MaxTicks

Parameters: SerialPort# specifies which instrument port (excluding the OS Port, port 0) will be monitored. The port must be open (see OpenSerial). “String” is a string with a maximum of 32 characters. MaxTicks is the maximum number of ticks (1/100ths of seconds) the loop will be allowed to run.

Action: Repeats script commands between this line and the next EndRepeat line, until the given string is received on the given port, or until MaxTicks pass, whichever happens first. String matching is case-sensitive. If SerialPort# is routed to a destination (see RouteSerial), routing is not affected by the string matching.

Return

Parameters: NONE

Action: Transfer control to the line following the associated GoSub call.

Sleep Seconds

Parameters: Time sets the number of seconds to wait (from start of last wait or sleep command). Time may be entered as either long integer seconds or in HH:MM:SS format.

Action: Put the DAS into low-power sleep mode for the indicated interval. All processor activity, including background serial transfers, will be halted. In the standard HydroDAS configuration, enabled power outputs will remain on, although this feature may be disabled on some systems.

SleepMod hh:mm:ss

Parameters: The modulus interval, in hours, minutes and seconds.

Action: The system will enter sleep mode until the next integer multiple of the given time.

SleepUntil [MM:DD:YY or NEXT] hh:mm:ss

Parameters: The date and time at which the sleep is to end. The date can also be replaced with the word NEXT, indicating either the current day, or the next day if the given time has passed.

Action: Put the DAS into low-power sleep mode until the indicated time and date. Background serial transfers and all other activity will be halted. Power outputs will remain on if the HydroDAS is suitably equipped, but digital outputs will all be set to zero.
Wait Seconds
Parameters: Seconds sets the number of seconds to wait (from start of last wait or sleep command). Seconds may be entered as either long integer seconds or in hh:mm:ss format.
Action: Pause script execution for the indicated time, as measured from the previous wait command. This method of timekeeping allows you to maintain precisely defined intervals between commands without knowing how long intervening tasks may take to execute. If you wish a Wait command to be executed without reference to a previous Wait, precede it with a Wait 0 command. Background serial transfers will continue and digital outputs and power switches will be stable.

WaitMod hh:mm:ss
Parameters: Sets the modulus interval in hours, minutes and seconds.
Action: The system will enter the wait state until the next integer multiple of hh:mm:ss

Waitticks ticks
Parameters: ticks is the time to wait, in hundredths of seconds.
Action: Pause script execution for the indicated delay. Background serial transfers will continue and digital outputs and power switches will be stable.

WaitUntil Date Time
Parameters: Date specifies the date that the sleep will end in MM:DD:YY format. Time specifies the end of the sleep in hh:mm:ss format. Date can also be replaced with the word NEXT, indicating either the current day, or the next day if the given time has passed.
Action: Go into low-power mode (but not sleep mode) Pause script execution until the indicated Date and Time. Background serial transfers will continue and digital outputs and power switches will be stable.

9.8.2 FILE OPERATIONS

AppendFile File# “Filename”
Parameters: File# is a number from 1 to 16 used to designate the file in subsequent operations. “Filename” is the name which will be given to the file on the flash disk.
Action: Open an existing output data file. If the file does not exist, a new file will be created. Otherwise, the data will be appended to the existing file.

CloseFile File#
Parameters: number of a currently open file
Action: Close the file.

Dir
Parameters: NONE
**Action:** Sends a directory of files in the current directory on the HydroDAS’s flash memory to host channel 253 (which is reserved for this purpose).

**NextSeqNum**

**Parameters:** NONE

**Action:** Increments the file sequence number used with all following calls to OpenFileSeq. The use of this separate function makes it possible to have a series of different file names with the same sequence number.

**Openfile File# “Filename”**

**Parameters:** File# specifies one of the 16 possible output data files. Filename is the name which will be given to the file on the flash disk.

**Action:** Open a new output data file. If the file exists, the new file will overwrite the previous file.

**OpenFileSeq File# “BaseName”**

**Parameters:** File# specifies the file number. “BaseName” is the base file name to which the sequence number will be added.

**Action:** Opens an output file with a sequential number suffix. The file name base should be limited to 5 letters in length to allow the suffix to be appended without exceeding the 8:3 DOS file name format. If the supplied name is too long, it will be truncated before the number is appended. The base name can include a full path name, if the path exists, and also an extension. For example, a base file name of “C:\direct\file.txt” will result in a file name in the form “C:\direct\file000.txt”. If the file already exists, data will be appended to it. The value of the inserted sequence number is controlled with the NextSeqNum and ResetSeqNum commands.

**RcvFile “Filename”**

**Parameters:** The name that will be assigned to the file on the HydroDAS flash disk.

**Action:** Receive a file sent by the host and store it with the given name. This command has no practical use for a human operator—it must be completed by the host software.

**ResetSeqNum NewSeqNum**

**Parameters:** Optional NewSeqNum specifies the sequence number to reset to. If omitted, resets to zero.

**Action:** Sets the file sequence number, used with calls to OpenFileSeq, to NewSeqNum (or zero if omitted).

**SendFile DestType Dest# “Filename”**

**Parameters:** DestType may be File or Serial. If a File, Channel designates the file number. Filename is an existing file on the flash disk.

**Action:** Send the contents of the file out a serial port, or to a file that has been opened with OpenFile or AppendFile. Note that this process may consume enough of the processor’s time to
disrupt background serial activities. If possible, avoid sending large files while collecting data through routed serial ports.

**SendHostfile “FileName”**

**Parameter:** The name of a file on the HydroDAS flash disk.

**Action:** Send the file on the host channel set aside for that purpose. No action in terminal mode.

**SendSeqNum DestType Dest#**

**Parameters:** *DestType* is Host, Serial or File. Channel specifies a host channel, serial port or file number.

**Action:** Sends the current value of the file sequence number that is used by OpenFileSeq (see also NextSeqNum, ResetSeqNum).

**StopTransfer**

**Parameters:** none.

**Action:** Halts the transfer of a file from the DAS to the host, if one is in progress. File transfers are initiated with the SendFile command.

### 9.8.3 SERIAL PORT OPERATIONS

**ClearBreak SerialPort#**

**Parameters:** *SerialPort#* selects one of the serial I/O ports.

**Action:** Reverses the effect of a SetBreak command, removing the high “break” signal from the output of the port.

**CloseSerial SerialPort#**

**Parameters:** *SerialPort#* selects the serial port for which transfer will halt.

**Action:** Close the serial port.

**OpenSerial SerialPort# Baud “params”**

**Parameters:** *SerialPort#* defines one of the attached serial ports. *Baud* defines the baud rate, which may range from 300 to 230,400 kbaud. “params” defines the serial port character format: Parity, number of data bits, and stop bits. “N81” is the standard data format which will be assumed if no configuration string is entered.

**Action:** Set up the UART for the channel

**RouteSerial SerialPort# DestType Channel**

**Parameters:** *SerialPort#* selects the serial port. *DestType* is a valid data destination (Host, File, Serial or None). Channel selects a file, host channel, or serial port.

**Action:** Set up automatic background transfer of incoming serial data.
SendBreak SerialPort# Ticks
   Parameters: SerialPort# selects one of the serial I/O channels. Ticks sets the duration of
   the break in ticks of 1/100th second.
   Action: Sends a serial break signal.

SetBreak SerialPort#
   Parameters: SerialPort# selects one of the serial I/O ports.
   Action: Sets the given serial port to a high output level (the port need not be open). The
   effect of this command is reversed with the ClearBreak command.

UnrouteSerial SerialPort#
   Parameters: SerialPort# selects the serial port for which transfer will halt.
   Action: Halt automatic transfer to the destination. Any data in buffers and queues will be
   transferred, then following data will be discarded. Unlike CloseSerial, leaves the port available
   for writing.

9.8.4 Digital I/O, Power

AnalogPower OnOff
   Parameters: Level is set to 0 (off) or 1 (on)
   Action: Turns on or off power to the analog subsystems of the HydroDAS. Analog power
   is on by default, and is turned on by HydroDAS whenever it is required. It can be turned off if no
   analog measurements are required in order to reduce the HydroDAS’s power consumption.

SendDigitalInput DestType Dest#
   Parameters: DestType and Dest# set the destination for the digital data.
   Action: Transfer states of all digital inputs to destination as a string of 1s and 0s.

SetDigital DigOut# OnOff
   Parameters: DigOut# defines the digital output pin to be affected. OnOff determines
   whether the output will be 0 or 1.
   Action: Set the level of a digital output pin.

SetPower PowerOut# OnOff
   Parameters: PowerOut# defines the power output pin to be affected. PowerOut# are
   numbered from 1 to the number of ports on the HydroDAS. OnOff determines whether the output
   will be off (0) or on (1).
   Action: Turn a power switch on or off. SetPower with both PowerOut# and OnOff values
   of zero turns off the analog subsystems in HydroDAS.
9.8.5 MESSAGES

Info InfoLevel

Parameter: InfoLevel is an integer from 0 to 4 controlling what type of automatically-generated messages will be sent to the console port. This is useful primarily for applications where the console port is used to interface to a telemetry system. Higher values correspond to higher rates of messages. This does not affect messages explicitly sent by commands such as “SendString”, only those that are indirectly generated by other functions.

The initial value is controlled by the INFO.LEVEL system variable (see section 8.3) and its default is 5.

<table>
<thead>
<tr>
<th>InfoLevel</th>
<th>Message Types Sent</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>None (except those sent by explicit commands)</td>
</tr>
<tr>
<td>1</td>
<td>Errors</td>
</tr>
<tr>
<td>2</td>
<td>Errors and informational</td>
</tr>
<tr>
<td>3</td>
<td>Errors, informational, and debugging</td>
</tr>
<tr>
<td>4 or higher</td>
<td>All</td>
</tr>
</tbody>
</table>

Action: No immediate action; controls what messages will be subsequently sent.

Log OnOff

Parameters: OnOff is a number (or defined constant) which determines whether logging information will be stored to the logging destination. (0 for no logging, 1 for logging).

Action: The script processor will write to the destination a string that describes each script line executed. This information is useful for debugging scripts.

LogDestination DestType Dest#

Parameters: Destination and channel specify where the log information will be written.

Action: This sets up logging of the script actions. The default destination is the OS/Debug port.

SendDate DestType Dest# “Separator” Format

Parameters: DestType and Dest# define the destination for the date string. “Separator” is a character or string placed between date fields. Format# is an integer.

Action: Write the current date (and optional time) to the destination. The given separator string is inserted between the month, day and year fields. The string is not terminated with a carriage return or line feed. The order and format of the month, day and year fields is determined by the format number as follows:

<table>
<thead>
<tr>
<th>Format#</th>
<th>Example</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Ignored</td>
<td>MM/DD/YYYY HH:MM:SS</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>-----</td>
<td>-------------</td>
</tr>
<tr>
<td>1</td>
<td>&quot;-&quot;</td>
<td>MM-DD-YY</td>
</tr>
<tr>
<td>2</td>
<td>&quot;-&quot;</td>
<td>MM-DD-YYYY</td>
</tr>
<tr>
<td>3</td>
<td>&quot;-&quot;</td>
<td>DD-MM-YY</td>
</tr>
<tr>
<td>4</td>
<td>&quot;-&quot;</td>
<td>DD-MM-YYYY</td>
</tr>
<tr>
<td>5</td>
<td>&quot;-&quot;</td>
<td>JJJ-YY</td>
</tr>
<tr>
<td>6</td>
<td>&quot;-&quot;</td>
<td>JJJ-YYYY</td>
</tr>
<tr>
<td>7</td>
<td>&quot;-&quot;</td>
<td>YY-JJJ</td>
</tr>
<tr>
<td>8</td>
<td>&quot;-&quot;</td>
<td>YYYY-JJJ</td>
</tr>
<tr>
<td>9</td>
<td>&quot;/&quot;</td>
<td>MM/DD/YY HH:MM:SS</td>
</tr>
<tr>
<td>10</td>
<td>&quot;/&quot;</td>
<td>MM/DD/YYYY HH:MM:SS</td>
</tr>
<tr>
<td>11</td>
<td>&quot;/&quot;</td>
<td>DD/MM/YY HH:MM:SS</td>
</tr>
<tr>
<td>12</td>
<td>&quot;/&quot;</td>
<td>DD/MM/YYYY HH:MM:SS</td>
</tr>
<tr>
<td>13</td>
<td>&quot;t&quot;</td>
<td>JJJ YY HH:MM:SS</td>
</tr>
<tr>
<td>14</td>
<td>&quot;t&quot;</td>
<td>JJJ YYYY HH:MM:SS</td>
</tr>
<tr>
<td>15</td>
<td>&quot;&quot;</td>
<td>YYYYJJ HH:MM:SS</td>
</tr>
<tr>
<td>16</td>
<td>&quot;&quot;</td>
<td>YYYYYYYY HH:MM:SS</td>
</tr>
<tr>
<td>17</td>
<td>&quot;&quot;</td>
<td>SSSSSSSSSSS</td>
</tr>
</tbody>
</table>

Note that formats 9 through 16 are the same as 1 through 8, with the addition of the time, preceded by a space, in HH:MM:SS format. For more control over the time format see the SendTime command.

Format 17 is the number of seconds since midnight, Jan. 1, 1970, a common time reference in UNIX-based systems. Unlike the other formats, the separator string, if any, is appended to the end of the time string.

The separator may be any character or short string.

**SendMuxStats**

**Parameters:** none

**Action:** Send statistics about the multiplexed host interface, on the host designated for status messages (252).

**SendSerNum DestType Dest#**

**Parameters:** *DestType* is Host, Serial or File. *Dest#* specifies the host channel, serial port, or file number.

**Action:** Sends the HydroDAS serial number and configuration date to the given destination.

**SendStatus DestType Dest#**

**Parameters:** *DestType* is Host, Serial or File. *Dest#* specifies host channel, serial port, or file number.
**Action:** Sends a string containing various status information to the given destination. The message is in the form:

22.3C, 13.05V, 0.10A, 0.0m, SOOCCCCCNNNN, P1100000000001010, RS

where the parameters are internal temperature, supply voltage, current consumption, depth (if the HydroDAS is equipped with a depth transducer), serial port status, power port status, and script status.

The string “SOOCCCCCNNNN” indicates that serial ports 1 and 2 are open, 3 through 7 are closed, and 9 through 11 are not installed.

The string “P1100000000001010” indicates that power ports 1 and 2 are on, and ports 3 through 12 are off. The last 4 digits of the string indicate the status of internal power settings.

The second character in the string starting with “R” indicates status of script loading and execution. Its possible values are:

- N  no script is loaded
- S  a script is loaded but has not yet run
- R  a script is running
- H  the loaded script was halted by a command
- D  “done”—the loaded script ran to completion and is now stopped.

### SendString DestType Dest# “String” TickDelay

**Parameters:** DestType and Dest# define the destination for the string. “String” is the output data to write (enclosed in quotation marks). TickDelay is the delay between characters, in 10 ms increments. TickDelay only affects data sent to serial ports.

**Action:** Write the string to the destination. If a non-zero TickDelay is specified, insert a corresponding delay between successive characters sent out serial ports. The string may contain control characters in C-language format.

### SendTime DestType Dest# “Separator”

**Parameters:** DestType and Dest# define the destination for the time string. “Separator” is a character or short string inserted between the fields of the time.

**Action:** Send a string representing the time to the given destination. The time is sent in the form HH[separator]MM[separator]SS (hours, minutes, seconds). The separator may be any character or short string, including a null string (“”). The time string is not terminated with a carriage return or line feed.

### SetInfoDest DestType

**Parameter:** DestType may be set to Host, Serial or None.

**Action:** Determines where informational messages are sent. If Host is specified, they are sent to host channel zero. If Serial is specified, they are sent to the debug port. If None, no messages are sent. Regardless of the Dest value, the Verbose environment variable must be set to 1 in order for messages to appear.
9.8.6  ANALOG INPUT

ResetAverage Average#

Parameters: Average# specifies one of 16 accumulators.

Action: The sum and count for the specified accumulator are reset. Having a separate command reset the average allow the data to be sent to multiple destinations before it is reset.

SendAnalog ADInput# DestType Dest#

Parameters: ADInput# defines the input analog channel to measure. DestType and Dest# set the destination for the analog data. Valid destinations are Host, Serial, File, and Average.

The definitions of the channel numbers depend on whether the HydroDAS has standard or extended analog inputs. Also, some functions appear at more than one channel number.

<table>
<thead>
<tr>
<th>Chan</th>
<th>HydroDAS Standard A/D</th>
<th>HydroDAS Extended A/D</th>
<th>MiniDAS</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>User input 1</td>
<td>User input 1</td>
<td>User input 1</td>
</tr>
<tr>
<td>2</td>
<td>User input 2</td>
<td>User input 2</td>
<td>User input 2</td>
</tr>
<tr>
<td>3</td>
<td>User input 3</td>
<td>User input 3</td>
<td>User input 3</td>
</tr>
<tr>
<td>4</td>
<td>User input 4</td>
<td>User input 4</td>
<td>User input 4</td>
</tr>
<tr>
<td>5</td>
<td>User input 5 or depth</td>
<td>User input 5</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Raw supply voltage</td>
<td>User input 6</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Raw internal temperature</td>
<td>User input 7</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Raw supply current</td>
<td>User input 8</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>--</td>
<td>User input 9</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>--</td>
<td>User input 10</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>--</td>
<td>User input 11</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>--</td>
<td>User input 12</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>--</td>
<td>User input 13</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>--</td>
<td>User input 14</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>--</td>
<td>User input 15</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>--</td>
<td>User input 16</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>User input 1</td>
<td>User input 1</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>User input 2</td>
<td>User input 2</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>User input 3</td>
<td>User input 3</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>User input 4</td>
<td>User input 4</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>User input 5 or depth</td>
<td>Depth (optional)</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>Raw supply voltage</td>
<td>Raw supply voltage</td>
<td>Raw supply voltage</td>
</tr>
<tr>
<td>23</td>
<td>Raw internal temperature</td>
<td>Raw internal temperature</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>Raw supply current</td>
<td>Raw supply current</td>
<td></td>
</tr>
</tbody>
</table>
**Action:** Collect one analog sample and transfer to the destination. The value is formatted as a voltage with four decimal places.

**SendAnalogDiff ADInput# DestType Dest#**

**Parameters:** `ADInput#` defines the input analog channel to measure. `DestType` and `Dest#` set the destination for the analog data. Valid destinations are Host, Serial, File, and Average.

**Action:** Collect one analog sample from a differential input channel and transfer to the destination. The given channel normally must be wired differentially in order to give correct results. However it is also possible to use SendAnalogDiff on pairs of channels that were not specifically wired for differential use. The following table shows which pairs of single-ended channels are combined to form differential channels.

<table>
<thead>
<tr>
<th>SendAnalog Diff Chan#</th>
<th>HydroDAS Extended A/D</th>
<th>MiniDAS</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>+1 – 8</td>
<td>+1 - 3</td>
</tr>
<tr>
<td>2</td>
<td>+2 – 9</td>
<td>+2 - 4</td>
</tr>
<tr>
<td>3</td>
<td>+3 – 10</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>+4 – 11</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>+5 – 12</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>+6 – 13</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>+7 – 14</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>+8 – 15</td>
<td></td>
</tr>
</tbody>
</table>

**SendAverage Average# DestType Dest#**

**Parameters:** `Average#` specifies one of 16 accumulators. `DestType` and `Dest#` set the destination for the averaged data.

**Action:** Transfer averaged data to a destination.

### 9.8.7 MISCELLANEOUS

**Define Name Value**

**Parameters:** `Name` is a string (not enclosed in quotation marks) defining a symbolic name for the numeric `Value`.

**Action:** Upon loading a script, HydroScript substitutes the numeric `Value` for each instance of `Name` in the script. For example, “Define cBetaPort 2” allows you to use the name `cBetaPort`, instead of the numeral 2, in script lines that require a numeric argument designating a particular instrument port.

**MountDisk**

**Parameters:** none
If a hard disk is included in the system, powers it and makes it available for OS operations. Also see UnmountDisk.

**OS “command”**

**Parameters:** “command” is a string containing a valid operating system (PicoDOS) command.

**Action:** The operating system command will be executed.

**SetConOut DestType Dest#**

**Parameters:** DestType can be Host, File or Serial

**Action:** Sets the destination for messages from the operating system. Normally these are sent to the operating system port (SERIAL 0), but they can be directed to another serial port or multiplexer channel with this command.

**SetLED Color (0,1,2)**

**Parameter:** Color is a number indicating the color state: 0 = off, 1 = Green, 2 = Red.

**Action:** Set the color state of the Led indicator on the outside of the HydroDAS case.

**SetProtocol Baudrate Protocol#**

**Parameters:** Baudrate is an integer that may be any standard baud rate from 9600 to 230400. Protocol# is an integer with value 1 (full handshaking), 2 (error detection) or 3 (terminal mode).

**Action:** Sets the baud rate and protocol of the host tem port.

**UnmountDisk**

**Parameters:** none

If a hard disk is included in the system and has been mounted (see MountDisk), powers it down and makes it unavailable for further operations.

### 9.8.8 SCRIPT CONTROL (see also section 9.4)

**CheckScript**

**Parameters:** none

**Action:** Checks the symbols in the currently loaded script. Used only for debugging.

**ClearScript**

**Parameters:** none

**Action:** Erases the current script (if any) from memory.
LoadScript “filename”
  Parameters: The name of an existing script file.
  Action: Loads a script into memory from the specified file on the HydroDAS flash disk.

RunScript
  Parameters: none
  Action: Runs the script currently in memory.

SaveScript “filename”
  Parameters: a valid file name for saving the script.
  Action: Saves the current temporary script file to a file with the given name. The temporary script file is built automatically by HydroDAS when it receives a script over channel 254.

SendParsed
  Parameters: none
  Action: Send the parsed script in memory to the host channel dedicated to scripts (channel 254).

9.9 Example Scripts

HydroScript offers so many capabilities it is impossible to formulate examples that demonstrate them all completely. Fortunately most users can let the Script Wizard do the work for them (see also section 7.1.16), and need not be concerned with the details. But for those who have special requirements, or simply prefer to explore the full capabilities of HydroDAS, the following examples illustrate some basic applications as a starting point.

9.9.1 Simple Analog Logging

The following simplistic example collects data from a single analog instrument referred to as “AirTemp”. Every 30 minutes it turns on power to the sensor, waits for it to warm up, averages 10 samples, then stores the averaged reading in a file with a date/time stamp. Then it sleeps until the next multiple of 30 minutes. The script contains an infinite loop, so it will continue until interrupted by an EndScript command from DASHost.

The Script Wizard generated this script, but the modularized structure it uses, which is designed to accommodate more complicated scripts, was simplified for presentation here.

; Symbolic constants indicating the sensor’s power and data ports, etc.
define On 1
define Off 0
define Power_AirTemp 8
define Data_AirTemp 2
define File_AirTemp 1
define Average_AirTemp 1

; Start of execution
MainLoop:
    ; sleep until an integral multiple of 1/2 hour
    SleepMod 00:30:00
    Gosub SampleData
; This script runs until an endscript command is received from the
; host. Pause briefly to listen for host commands before going to sleep
    Wait 5
    Goto MainLoop

SampleData:
    ; open the file into which data will be stored
    AppendFile File_AirTemp "AirT.txt"
    ; turn on power
    SetPower Power_AirTemp On
    Wait 0
    Wait 2 ; wait 2 seconds for sensor to warm up
    ; prepare to average a number of data samples
    ResetAverage Average_AirTemp
    Repeat 10
        SendAnalog Data_AirTemp Average Average_AirTemp
    EndRepeat
    ; store the averaged result in the file, tagged with the date and time
    SendDate File File_AirTemp
    SendString File File_AirTemp ","
    SendAverage Average_AirTemp File File_AirTemp
    SendString File File_AirTemp "\r"
    CloseFile File_AirTemp
    SetPower Power_AirTemp Off
Return

9.9.2 Multiple Serial Instruments

This script handles three serial-port instruments: a HOBI Labs HydroScat-2, a WET Labs AC9, and a Seabird CTD. Initially it waits in the low-power sleep state indefinitely. HydroDAS’s magnetic switch can be used to wake it from this state and commence the logging.
This is intended for a scenario where the logging needs to be started by an operator after deployment, but without connecting to a host computer.

After initial wakeup, the script logs data for 5 minutes every 30 minutes, on the half-hour, except between the hours of 8:00PM and 6:00AM. Each time it samples, it applies power to the instruments, opens their serial ports, opens files to collect their serial output, and send the commands they require (if any) to commence data collection. After collecting for five minutes it sends commands to terminate collection, closes the files and serial ports, and goes to sleep until the next half-hour interval.

The following script was generated by the Script Wizard and slightly edited for clarity. The symbolic constants and most of the comments were generated automatically by the Script Wizard.

```plaintext
define On 1
define Off 0
define Power_AC9 2
define Data_AC9 2
define File_AC9 1
define Power_CTD 4
define Data_CTD 4
define File_CTD 1
define Power_HS2 5
define Data_HS2 5
define File_HS2 1

; HydroDas will go to sleep and not start the script until woken up
; Thus it can be set up and remain asleep until logging is started by
; the magnetic switch
Sleep 1000000000

MainLoop:
  ; Increment Counter for Sequentially numbered files.
  NextSeqNum
  ; Wake up every 30 minutes to collect data
  SLEEPMOD 00:30:00
  ; But do not collect data outside of normal collection times
  GosubDuring 20:00:00 06:00:00 BlackOut
  ; Now collect the data
  Gosub DoDataCollect
```
; Pause so that an endscript can be received from host
Wait 5
; Loop back indefinitely
Goto MainLoop

; Sleep during blackout times
BlackOut:
    SleepUntil 06:00:00
Return

DoDataCollect:
    Gosub PowerOn
    ; Now Synchronize the Timer
    Wait 0
    Repeat 300
        ; Sample the Data for 1 Seconds
        Gosub SampleData
    EndRepeat
    Gosub PowerOff
; And Finish
Return

; Instrument Turn-on Routine—incorporates instrument parameters
; specified in DASHost’s Instrument Setup
PowerOn:
    OpenFileSeq File_AC9 ""
    OpenSerial Data_AC9, 19200, "N81"
    RouteSerial Data_AC9 File File_AC9
    SendSerial Data_AC9
    SendString File File_AC9 "\r"
    SetPower Power_AC9 On
    WaitTicks 30
    OpenFileSeq File_CTD ""
    OpenSerial Data_CTD, 600, "E71"
    RouteSerial Data_CTD File File_CTD
    SendSerial Data_CTD
    SendString File File_CTD "\r"
    SetPower Power_CTD On
    WaitTicks 30
    OpenFileSeq File_HS2 ""
OpenSerial Data_HS2, 57600, "N81"
RouteSerial Data_HS2 File File_HS2
SendSerial Data_HS2
SendString File File_HS2 "\r"
SetPower Power_HS2 On
WaitTicks 80
SendString Serial Data_CTD "\r\r", 0
SendString Serial Data_HS2 "Start\r\r", 0
waitticks 50
SendString Serial Data_CTD "\r\r", 0
waitticks 50
SendString Serial Data_CTD "\r\r", 0
waitticks 50
SendString Serial Data_CTD "\r\r", 0
waitticks 50
SendString Serial Data_CTD "GL\r\r", 0
waitticks 100
SendString Serial Data_CTD "Y\r\r", 0
waitticks 100
SendString Serial Data_CTD "\x19\r\r", 0
; Done with Power-On
Return

; Data Sampling Loop - 1 Second Duration
; Serial ports routed to files continue in background
SampleData:
   Wait 1
Return

; Instrument Data-off and Turn-off Routine
PowerOff:
   SendString Serial Data_CTD "\x1A\r", 0
   SendString Serial Data_HS2 "Stop\r\r", 0
   waitticks 20
   SendString Serial Data_CTD "\r\r", 0
   SendString File File_AC9 "\r"
   CloseSerial Data_AC9
   CloseFile File_AC9
   SetPower Power_AC9 Off
   WaitTicks 50
   SendString File File_CTD "\r"
   SendString File File_HS2 "\r"
CloseSerial Data_CTD
CloseSerial Data_HS2
SetPower Power_CTD Off
SetPower Power_HS2 Off
; Done with Power-Off
Return
The optional USB data offload interface allows retrieving logged data from flash or hard disk storage at rates up to 200 kBytes/sec, about 20 times faster than the host interface. Systems equipped with this option include the following required items:

- USB adapter cable
- USB.pxe executable loaded on the DAS
- USBLink software for the host computer
- USB drivers for the host computer

To offload data, first connect a serial port on your PC to the OS/Debug port on the DAS. Use HyperTerminal or another communications program to connect to the port at 9600 baud, 8 bits, no parity. Type **EXIT<enter>** to quit the standard firmware and get the operating system prompt. At the OS prompt, type **USB<enter>**, and you should next receive a message confirming that the USB program is running and ready to receive data.

Without removing power from the HydroDAS, connect your computer’s USB port to the DAS USB connector. Your computer should shortly indicate that a new USB device has been connected. The first time you do this you may have to load the supplied drivers on your computer, following the instructions shown by Windows.

Next, run the USBLink program on your computer. You should see a window like the following:

![USBLink](image)

Click **OPEN USB** to activate the connection. “No Connection” should change to “HydroDAS USB”. Then click **Get Directory** to display a list of the available files. To move to the next higher directory, if any, click on the “.” that appears at the top of the list. Drive C: is
normally assigned to the flash disk in the HydroDAS. If your system includes a hard disk, it will normally appear as drive D. Additional partitions may appear as higher drive letters. Select the drive and directory containing the files you wish to copy. Then select any group of files. Ctrl-click to add or remove individual files from the selection. Click-drag to select a contiguous group.

In the right panel, select the directory into which you wish to copy the files. Finally, click the Transfer button. The files will be copied with the same names they have on the HydroDAS. **Note that if files with the same names already exist in the designated directory, they will be overwritten.**

When finished with all desired transfers, click Exit. To return the HydroDAS to its normal mode of operation, reset it either by cycling its power, or by sending a reset signal to the host port via DASHost. Note that DASHost will not recognize the HydroDAS is present until after the reset has taken effect.
11 CUSTOMER SERVICE

If your HydroDAS needs to be returned to HOBI Labs for repair, maintenance or calibration, please first obtain a return material authorization (RMA) from HOBI Labs. To establish an RMA HOBI Labs will request the following information:

- Instrument Serial Number
- Reason for return
- Point of contact
- Date needed (allow minimum 3-4 week turnaround)
- Address for return delivery

For contact details, please visit our web site at www.hobilabs.com.

Once we receive and inspect the equipment, we will contact you as soon as possible with estimated cost and turnaround time. Repairs will not be started until customer approves cost estimate and turnaround time.